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Safety warning notice

/\ WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description HP EliteBook 8570p HP ProBook 6570b
Notebook PC Notebook PC
Product Name HP ProBook 8570p Notebook PC J
HP ProBook 6570b Notebook PC v
Processors ®  Intel® Quad Core® i7-3740QM V

2.70-GHz processor (SC turbo up to
3.70-GHz; 1600-MHz FSB, 6.0-MB
L3 cache, 45 W)

e Intel Quad Core i7-3720QM 2.60-
GHz processor (SC turbo up to 3.60-
GHz; 1600-MHz FSB, 6.0-MB L3
cache, 45 W)

e Intel Quad Core i7-3630QM 2.40-
GHz processor (SC turbo up to 3.40-
GHz; 1600-MHz FSB, 6.0-MB L3
cache, 45 W)

e Intel Quad Core i7-3610QM 2.30-
GHz processor (SC turbo up to 3.30-
GHz; 1600-MHz FSB, 6.0-MB L3
cache, 45 W)
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Category

Description

HP EliteBook 8570p
Notebook PC

HP ProBook 6570b
Notebook PC

Intel Dual Core i7-3540M 3.00-GHz
processor (SC turbo up to 3.70-GHz;
1600-MHz FSB, 4.0-MB L3 cache,
45 W)

Intel Dual Core i7-3520M 2.90-GHz
processor (SC turbo up to 3.60-GHz;
1600-MHz FSB, 4.0-MB L3 cache,
35W)

Intel Dual Core i5-3380M 2.90-GHz
processor (SC turbo up to 3.60-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35W)

Intel Dual Core i5-3360M 2.80-GHz
processor (SC turbo up to 3.50-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35W)

Intel Dual Core i5-3340M 2.70-GHz
processor (SC turbo up to 3.40-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35W)

Intel Dual Core i5-3320M 2.60-GHz
processor (SC turbo up to 3.30-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35W)

Intel Dual Core i5-3230M 2.60-GHz
processor (SC turbo up to 3.20-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35W)

Intel Dual Core i5-3210M 2.50-GHz
processor (SC turbo up to 3.10-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35W)

\/

\/

Intel Dual Core i3-3130M 2.60-GHz
processor (1333-MHz FSB, 3.0-MB
L3 cache, 35 W)

Intel Dual Core i3-3120M 2.50-GHz
processor (1333-MHz FSB, 3.0-MB
L3 cache, 35 W)

Intel Dual Core i3-3110M 2.40-GHz
processor (1600-MHz FSB, 3.0-MB
L3 cache, 35 W)

Intel Dual Core i3-2370M 2.40-GHz
processor (1333-MHz FSB, 3.0-MB
L3 cache, 35 W)

Chipset

Mobile Intel QM77 chipset

Chapter 1

Product description



Category Description HP EliteBook 8570p HP ProBook 6570b
Notebook PC Notebook PC

Mobile Intel HM76 chipset \

Graphics Switchable discrete graphics: AMD J
Radeon™ HD 7570M, with support for
DisplayPort 1.2 and up to 4 displays
through the APR

Internal graphics:

e Universal memory architecture (UMA)
with shared video memory

e Intel HD Graphics 4000

Switchable discrete graphics: AMD \/
Radeon™ HD 7570M, with support for

DisplayPort 1.2 and up to 4 displays

through the APR

Internal graphics:

e Universal memory architecture (UMA)
with shared video memory

e Intel HD Graphics 4000 on computer
models equipped with an Intel Core
i7, Intel Core i5, and Intel Core
i3-3110 processor

e Intel HD Graphics 3000 on computer
models equipped with an Intel Core
i3-2370 processor

Panel e 15.6-in lightemitting diode (LED), full- J \/
high definition (FHD), AntiGlare (AG),
WVA (1920x1080) display with and
without webcam, microphones, and
keyboard light

e 15.64in LED, HD+, AG, WVA
(1900x1600) display with and
without webcam, microphones, and
keyboard light

° 15.6-in LED, HDm AG, SVA
(1366x768) display with and without
webcam, microphones, and

keyboard light

All display assemblies include two or three
wireless local area network (WLAN)
antenna cables and two wireless wide
area network (WWAN) antenna cables

Supports low voltage differential
signalling (LVDS)

Supports 16:9 aspect ratio
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Category Description HP EliteBook 8570p HP ProBook 6570b
Notebook PC Notebook PC
Memory Two customer-accessible/upgradable \ \/
memory module slots
DDR3-1600-MHz dual channel support
Supports 16384-MB of system RAM in the
following configurations:
e 16384-MB (8192-MBx2)
e 8192-MB (8192-MBx1 or 4096x2)
e 8192-MB (8192-MBx1 or 4096x2;
not supported on computer models
equipped with a 32-bit
operating system)
o 6144-MB (4096-MB+2048-MB)
e 4096-MB (4096-MBx1 or 2048-
MBx2)
o 2048MB (2048x1)
Hard drive Supports 6.35-cm (2.5-in) hard drives in \ J

9.5-mm (.37-in) and 7.0-mm (.28-in)
thicknesses (all hard drives use the
same bracket)

Customer-accessible

Serial ATA

Suppors the following hard drives:

e 750-GB, 7200-rpm, 9.5-mm

e  500-GB, 7200-rpm, 9.5-mm self-
encrypting drive (SED)

e  500-GB, 7200-rpm, 9.5-mm

e  320-GB, 7200-rpm, 9.5-mm

Chapter 1
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Category Description HP EliteBook 8570p HP ProBook 6570b
Notebook PC Notebook PC

Solid-state drive Solid-state drive (SSD) mounts in the same \/
bracket as the hard drive

Customer-accessible

Serial ATA llI

Supports the following SSDs:
e 256-GB SED

e  240-GB

e 180-GB

e 160-GB

e 128GB

Supports the following SSDs: y
e 180-GB
e 160-GB

e 128GB

Upgrade drive Customer-accessible J \/
Supports the following drive options:

e Blu-ray ROM DVD+RW SuperMulti
DL Drive

e DVD2RW Double-layer with
SuperMulti Drive

e  DVD-ROM Drive
e 500-GB, 7200-rpm, 9.5-mm

Supports no drive option

Optical drive Fixed J \
Serial ATA
12.7-mm tray load
Supports the following optical drives:

e Bluray ROM DVD+RW SuperMulti
DL Drive

e DVDxRW Double-layer with
SuperMulti Drive

e DVD-ROM Drive

Supports zero power optical drive
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Category Description HP EliteBook 8570p HP ProBook 6570b
Notebook PC Notebook PC
Audio and video Two stereo speakers \ \/
HD audio with SRS Premium Sound PRO 3 J
Integrated 720p HD webcam (supports no y J
camera option)
Integrated dual-array microphone on y J
computer models equipped with a webcam
Integrated mono microphone on computer
models not equipped with a webcam
Modem 56kbps v.92 MDC data/fax v v
modem module
Supports no modem option
Modem module cable not included
Ethernet Intel 82579LM 10/100/1000 Ethernet 3 J
network interface card (NIC) with
iAMT Intel 82579LM Gigabit
Network Connection
NIC Power Down technology
S3/54/55 wake on LAN
Ethernet cable not included
Wireless Integrated wireless personal area network y J

(WPAN) option by way of Bluetooth 4.0

enhanced data rate (EDR) module

Supports no WPAN option

Chapter 1 Product description



Category Description HP EliteBook 8570p HP ProBook 6570b

Notebook PC Notebook PC

Integrated wireless local area network J 3
(WLAN) options by way of
wireless module
Three WLAN antennas built into
display assembly
Support for the following WLAN formats:
e Atheros WB225 1x1 802.11b/g/n

Bluetooth Combo Adapter
e  Broadcom 43228 802.11abgn 2x2

Wi-Fi Adapter
e Intel Centrino Advanced-N 6205

WILAN module
e Intel Centrino Ultimate-N 6300

WILAN module
e Intel Centrino Wireless-N 2200

802.11b/g/n 2x2 WiFi Adaptor
Supports no WLAN option
Integrated wireless wide area network V 3

(WWAN) options by way of
wireless module

Two world-wide/5-band WWAN
antennas built into display assembly

Secured by subscriber identity module
(SIM, user-accessible behind battery)

Support for the following WWAN formats:

e HP hs2350 HSPA+ Mobile
Broadband Module

° HP 1t2523 LTE/HSPA+ Mobile
Broadband Module

° HP 1t2522 LTE/EV-DO Mobile
Broadband Module

e HP un2430 EV-DO/HSPA Mini Card

e  HP un2430 EV-DO/HSPA Mobile
Broadband Module

Supports no WWAN option

Supports WWAN after market option




Category Description HP EliteBook 8570p HP ProBook 6570b

Notebook PC Notebook PC

External media cards Integrated 54-mm ExpressCard y J

Secure Digital (SD) flash media slot with

push-push technology, supporting the

following digital card formats:

e  MultiMediaCard (MMC)

e  MMC+

e  Secure Digital (SD) Memory Card

e SDHC

e SDXC
Ports e 1394a port \ J

e Audio-in (mono microphone)
e Audio-out (stereo headphone)
e  Battery connector

e DisplayPort 1.2 (on computer models
equipped with a graphics subsystem
with discrete memory)

e DisplayPort 1.1a (on computer
models equipped with a graphics
subsystem with UMA memory)

e Docking connector

e  eSATA/USB 2.0 combo port

e HP Smart AC adapter

e RJ-45 (Ethernet)

e RJ-11 (modem)

e  Secondary battery connector

e  Serial port

e USB 3.0 ports (2)

e USB 2.0 port

e USB 2.0 charging port

e VGA (Dsub 15 pin) supporting:
1920x1200 external resolution @
75 Hz, hot plug and unplug and

autodetection for correct output to
wide-aspect vs. standard aspect video

Chapter 1 Product description



Category Description HP EliteBook 8570p HP ProBook 6570b

Notebook PC Notebook PC
Keyboard/pointing Fullsize keyboard with numeric keypad J \
devices (upper-left justified), dual-point, spill-
resistant, chicletstyle, with durakeys
Gesture support: MultiTouch gestures \/ \
enabled, two-inger scrolling, and pinch-
zoom as default
Taps enabled by default J y
Support for TouchPad with image sensor \/ \
Support for Windows 8 Indirect Touch J \/
Power requirements Supports the following HP Smart AC adapters:
e 90-W HP Smart AC adapter (PFC, J \
EM, 3-wire)
e 90-W HP Smart AC adapter (PFC, 3- J \
wire)
e 65W HP Smart AC adapter (non- \/ \
PFC, 3-wire)
e 65W HP Smart AC adapter (RC/V, v v
EM, 3-wire)
Supports the following batteries: J 3
e 9cell, 100-Wh, 3.0-Ah battery
®  9cell, 73-Wh, 2.2-Ah battery
o 6ecell, 62-Wh, 2.8-Ah battery
e 6cell, 55-Wh, 2.8-Ah battery
e 3cell, 31-Wh, 2.8-Ah battery
Security Supports security cable lock J \/
Supports fingerprint reader and no J y
fingerprint reader option
Supports Trusted Platform Module (TPM) J y
1.2 (Infineon, soldered down) and
TPM Enhanced Drive Lock (not supported
in Asia and the People's Republic
of China)
Integrated Smart Card reader (active) \ v
Full volume encryption S v
Preboot authentication (password, J y

Smart Card)




Category Description HP EliteBook 8570p HP ProBook 6570b
Notebook PC Notebook PC

Operating system Preinstalled: \ \/

e Windows® 8 ML 64 with Microsoft
Basics (Japan only)

®  Windows 8 Professional 64 with
Microsoft Basics (Japan only)

e Windows 8 Professional 64 DPK with
Windows 7 Professional 64 and 32
(Japan only)

e Windows 7 Home Premium 64 and
32 with Microsoft Basics

e Windows 7 Professional 64 and 32
with Microsoft Basics

®  Windows 7 Service Pack 1
e FreeDOS

e  SUSE Linux (SLED; People's Republic
if China only)

10 Chapter 1 Product description



Category

Description

HP EliteBook 8570p HP ProBook 6570b

Notebook PC

Notebook PC

Preinstalled with Microsoft Office:

Windows 8 CH 64-bit with Office
2010 Transition OPK (People's
Republic of China only)

Windows 8 EM 64-bit with Office
2010 Transition OPK (not available
in Japan)

Windows 8 ML 64-bit with Office
2010 Business and Home

(Japan only; requires configuration
with Office Personal Japan 2010 app
AV)

Windows 8 ML 64-bit with Office
2010 Personal (Japan only; requires

configuration with Office Personal
Japan 2010 app AV)

Windows 8 ML 64-bit with Office
2010 Professional (Japan only;
requires configuration with Office
Personal Japan 2010 app AV)

Windows 8 ML 64-bit with Office
2010 Transition OPK (not available
in Japan)

Windows 8 Professional 64-bit DPK
with Windows 7 Professional 64- and
32-bit with Office 2010 Business and
Home (Japan only; requires
configuration with Office Personal

Japan 2010 app AV)

Windows 8 Professional 64-bit DPK
with Windows 7 Professional 64- and
32-bit with Office 2010 Personal
(Japan only; requires configuration
with Office Personal Japan 2010 app
AV)

Windows 8 Professional 64-bit DPK
with Windows 7 Professional 64- and
32-bit with Office 2010 Professional
(Japan only; requires configuration
with Office Personal Japan 2010 app
AV)

Windows 8 Professional 64-bit DPK
with Windows 7 Professional 64- and
32-bit with Office 2010 Starter (not
available in Asia-Pacific countries
and regions, Japan, or the People's
Republic of China)

Windows 8 Professional 64-bit with
Office 2010 Business and Home
(Japan only; requires configuration
with Office Personal Japan 2010 app
AV)

Windows 8 Professional 64-bit with

~Fff ~Ssn"nI1AnAD Vv err

\/

\/
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Category Description HP EliteBook 8570p HP ProBook 6570b

Notebook PC Notebook PC

Preinstalled with Microsoft Office: v N
(Continued)
®  Windows 7 Professional 64- and 32-

bit with Office 2010 Starter (not

available in Japan)
®  Windows 7 Professional 64- and 32-

bit with Office 2010 Business &

Home (only in Japan)
®  Windows 7 Professional 64- and 32-

bit with Office 2010 Personal (only

in Japan)
®  Windows 7 Professional 64- and 32-

bit with Office 2010 Professional

(only in Japan)
Restore media—DR-DVD: \ \

®  Windows 8 (available with any
Windows 8 operating system and
required with Windows 8
Professional 64-bit DPK with
Windows 7 image)

®  Windows 7 (available with any
Windows 7 HP, Windows 7
Professional loc, Windows 7 HB, or
Windows 8 Professional 64-bit DPK
with Windows 7 image)

12 Chapter 1 Product description



Category Description HP EliteBook 8570p HP ProBook 6570b
Notebook PC Notebook PC

Restore media—0OS-DVD: N v

®  Windows 8 Professional 64-bit
(required with Windows 8
Professional 64-bit DPK with
Windows image)

e Windows 7 Home Basic 32-bit
(available with any Windows 7
Home Basic location except Asia-
Pacific countries and regions and the
People's Republic of China)

e Windows 7 Home Premium 64- and
32-bit (available with any Windows
7 Premium location except Asia-
Pacific countries and regions and the
People's Republic of China)

®  Windows 7 Professional 64- and 32-
bit (available with any Windows 7
Professional or Windows 8
Professional 64-bit DPK with
Windows image location except
Asia-Pacific countries and regions
and the People's Republic of China)

Certified: N v
®  Microsoft WHQL

e  SuSE Linux Enterprise (SLED) 64-bit
Service Pack 2




Category Description HP EliteBook 8570p HP ProBook 6570b

Notebook PC Notebook PC
Web-only support: \ \/
e Windows 8 32-bit
®  Windows XP Pro 32-bit
e Windows 7 Enterprise 64- and 32-bit
*  Windows 7 Ultimate 64- and 32-bit
Serviceability End user replaceable parts: y J

e AC adapter

e  Battery
e Hard drive
e Keyboard

®  Memory module
e mSATA drive

e Optical drive

e Solid-state drive
e WIAN module

e WWAN module

14 Chapter 1 Product description



2 External component identification

= ===
Lod L=dLad

Item

Component

Description

m

Internal display switch

Turns off the display or initiates Suspend if the display is
closed while the power is on.

NOTE: The display switch is not visible from the outside
of the computer.

(2)

WLAN antennas (3)*

Send and receive wireless signals to communicate
with WLANSs.

(3)

Internal microphones (2)

Record sound.

4

Webcam light (select models only)

On: The webcam is in use.

(5)

Webcam (select models only)

Records video and captures still photographs.

Display

15



Item Component Description

6) Keyboard light button (select models only)  Turns the keyboard light on or off.
(7) Keyboard light (select models only) llluminates the keyboard, especially in low-light
conditions.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region.

16 Chapter 2 External component identification



Buttons and fingerprint reader (select models only)

E"%NOTE: Your computer may look slightly different from the illustration in this section.

ltem Component Description
(1) TouchPad on/off button Turns the TouchPad on and off.
(2) Power button e When the computer is off, press the button to turn on

the computer.

e When the computer is on, press the button briefly to
initiate Suspend.

®  When the computer is in the Suspend state, press
the button briefly to exit Suspend.

e When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and operating
system shutdown procedures are ineffective, press and
hold the power button for at least 5 seconds to turn off
the computer.

To learn more about your power settings:

e Windows 8—From the Start screen, type power,
select Settings, and then select Power Options.

e Windows 7:
1. Select Computer > Control Center.

2. Inthe left pane, click System, and then click
Power Management in the right pane.

Buttons and fingerprint reader (select models only)

17



Item Component Description

(3) Wireless button Turns the wireless feature on or off but does not establish
a wireless connection.

NOTE: A wireless connection may be established if
one has been previously configured.

(4) Web browser button ®  When the computer is on, press the button to open
the default Web browser.

®  When the computer is off, in the Suspend state, or
in Hibernation, the button does not perform any
action or function.

(5) Volume mute button Mutes and restores speaker sound.
(6) Calculator button Opens the calculator function.
(7) Fingerprint reader (select models only) Allows a fingerprint logon instead of a password logon.

Keys

@NOTE: Your computer may look slightly different from the illustration in this section.

- -
Item Component Description
(1) Function key Execute frequently used system functions when pressed in
combination with the fn key.
(2) fn key Executes frequently used system functions when pressed

in combination with a function key.
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Item Component Description

(3) num lock key Turns the embedded numeric keypad on and off when
pressed in combination with the fn key.
Alternates between the navigational and numeric
functions on the integrated numeric keypad.

(4) Integrated numeric keypad When num |k has been enabled, the keys can be used

like an external numeric keypad. To alternate between
this numeric function and the navigational function
(indicated by the directional arrows on the keys), press
the num Ik key.

Keys
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Lights

@NOTE: Your computer may look slightly different from the illustration in this section.

]

Item Component Description
(1) TouchPad light e Amber: The TouchPad is off.
e Off: The TouchPad is on.
(2) Caps lock light On: Caps lock is on.
(3) Power light e On: The computer is on.
e Blinking: The computer is in the Suspend state.
e Off: The computer is off or in Hibernation.
(4) Wireless light e White: An integrated wireless device, such as a
WILAN device and/or a Bluetooth device, is on.
e Amber: All wireless devices are off.
(5) Web browser light e On: The computer is on.
e Off: The computer is off, in the Suspend state, or
in Hibernation.
e Blinking: The web browser has been activated.
(6) Mute light e Amber: Computer sound is off.
°

Off: Computer sound is on.
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Item

Component

Description

)]

Calculator light

e On: The calculator function is on.
e Blinking: The calculator has been activated.

e Off: The computer is off, in the Suspend state, or
in Hibernation.

(8)

Num lock light

On: Num lock is on.

TouchPad

[/ NOTE:  Your computer may look slightly different from the illustration in this section.

Item

Component

Description

m

Pointing stick (select models only)

Moves the pointer and selects or activates items on
the screen.

(2)

Left pointing stick button

Functions like the left button on an external mouse.

(3)

TouchPad on/off button

Turns the TouchPad on or off.

(4)

TouchPad zone

Moves the pointer and selects or activates items on
the screen.

(5)

Left TouchPad button

Functions like the left button on an external mouse.

TouchPad
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Item

Component

Description

(6)

Right TouchPad button

Functions like the right button on an external mouse.

7

Right pointing stick button

Functions like the right button on an external mouse.

Front

@NOTE: Your computer may look slightly different from the illustration in this section.

‘\\\

OOS

Item

Component

Description

m

Display release latch

Opens the computer.

(2)

Wireless light

White: An integrated wireless device, such as a
WILAN device and/or a Bluetooth device, is on.

Amber: All wireless devices are off.

3)

Power light

On: The computer is on.
Blinking: The computer is in the Suspend state.

Off: The computer is off or in Hibernation.

4

AC adapter/Battery light

Amber: The computer is connected to external
power and the battery is charged from O to
90 percent.

White: The computer is connected to external power
and the battery is charged from 90 to 99 percent.

Blinking amber: A battery that is the only available
power source has reached a low battery level.
When the battery reaches a critical battery level, the
battery light begins blinking rapidly.

Off: The battery is fully charged.

(5)

Hard drive light

Blinking white: The hard drive or optical drive is
being accessed.

Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

(6)

Speakers (2)

Produce sound.
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Left side

E"%NOTE: Your computer may look slightly different from the illustration in this section.

ltem Component Description

(1) USB 2.0 ports (2) Connect optional USB devices.

(2) ExpressCard slot Supports optional ExpressCards.

(3) Media Card Reader Supports the following digital card formats:

e MultiMediaCard (MMC)

°  MMC+

e Secure Digital (SD) Memory Card
e SDHC

e SDXC

(4) 1394 port Connects an optional IEEE 1394 or 1394a device, such
as a camcorder.

(5) Vents (2) Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(6) eSATA/USB 2.0 port Connects an optional high-performance eSATA
component, such as an eSATA external hard drive, or
connects an optional USB device.

(7) External monitor port (VGA) Connects an external VGA monitor or projector.

(8) Smart Card reader Supports optional smart cards.

Left side
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Right side

@NOTE: Your computer may look slightly different from the illustration in this section.

S

7
-

T
@

DOS

s

l'

Item Component

Description

(1) Audio-out (headphone) jack

Produces sound when connected to optional powered
stereo speakers, headphones, earbuds, a headset, or
television audio. Also connects an optional

headset microphone.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
refer to the Regulatory, Safety, and

Environmental Notices.

NOTE: When a device is connected to the jack,
the computer speakers are disabled.

(2) Audio-in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

3) USB 3.0 ports (2)

Connect optional USB 3.0 devices.

(4) Upgrade bay (optical drive shown)

The upgrade bay can hold a weight-saver option, a hard
drive, or an optical drive that reads an optical disc.

NOTE: On select models, the optical drive also writes
to an optical disc.

(5) Upgrade bay eject button

Releases the optical drive disc tray.

(6) RJ-45 (network) jack

Connects a network cable.

(7) Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deferrent, but it may not prevent the computer from being
mishandled or stolen.
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Bottom

E’%NOTE: Your computer may look slightly different from the illustration in this section.

6

Item

Component

Description

m

Battery release latch

Releases the battery.

(2)

Docking connector

Connects an optional docking device.

(3)

Service cover release latch

Releases the service cover from the computer.

4)

Battery bay

Contains the battery.

(3)

Vents (3)

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(6)

Speakers (2)

Produce sound.

7)

Bluetooth compartment

Contains a Bluetooth device (select models only).

Bottom
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Item Component Description

(8) Service cover Provides access to the hard drive, and also contains the
WILAN module slot and the memory module slots.
CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact support.

(9) Accessory battery connector Connects an optional accessory battery.
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Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 81 for battery removal instructions.

( [/ OO0
Serial: 200000COC M0 R0 TR

(2
8:—F'mdlld'. FOCOCOOC. NN
__Warranty: 1yly0y

e

ltem Description Function

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about
the product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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Item Component Spare part number

(1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see Display assembly subcomponents on page 44.

(2) Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models (includes keyboard
cable and pointing stick cable

For use only on computer models equipped with the Windows 8 operating system:

For use in Belgium 701986-A41
For use in Brazil 701986-201
For use in Bulgaria 701986-261
For use in Canada 701986-DB1
For use in the Czech Republic and Slovakia 701986-FL1

For use in Denmark 701986-081
For use in France 701986-051
For use in Germany 701986-041
For use in Greece 701986-151
For use in Hungary 701986-211
For use in Iceland 701986-DD1
For use in India 701986-D61
For use in Israel 701986-BB1
For use in ltaly 701986-061
For use in Japan 701986-291
For use in Latin America 701986-161
For use in the Netherlands 701986-B31
For use in Norway 701986-091
For use in Northwest Africa 701986-FP1

For use in Portugal 701986-131
For use in Romania 701986-271
For use in Russia 701986-251
For use in Saudi Arabia 701986-171
For use in Slovenia 701986-BA1
For use in South Korea 701986-AD1
For use in Spain 701986-071
For use in Sweden and Finland 701986871
For use in Switzerland 701986BG1
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Item Component Spare part number
For use in Taiwan 701986-AB1
For use in Thailand 701986-281
For use in Turkey 701986-141
For use in the United Kingdom and Singapore 701986-031
For use in the United States 701986-001
For use only on computer models equipped with the Windows 7 operating system:

For use in Belgium 686318-A41
For use in Brazil 686318-201
For use in Bulgaria 686318261
For use in Canada 686318-DB1
For use in the Czech Republic and Slovakia 686318-FL1

For use in Denmark 686318-081
For use in France 686318-051
For use in Germany 686318-041
For use in Greece 686318-151
For use in Hungary 686318-211
For use in Iceland 686318-DD1
For use in India 686318-D61
For use in Israel 686318BB1
For use in Italy 686318-061
For use in Japan 686318291
For use in Latin America 686318-161
For use in the Netherlands 686318831
For use in Northwest Africa 686318-FP1

For use in Norway 686318-091
For use in Portugal 686318-131
For use in Romania 686318-271
For use in Russia 686318-251
For use in Saudi Arabia 686318171
For use in Slovenia 686318-BA1
For use in South Korea 686318-AD1
For use in Spain 686318-071

Computer major components
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ltem Component Spare part number

For use in Sweden and Finland 686318871
For use in Switzerland 686318-BG1
For use in Taiwan 686318-AB1
For use in Thailand 686318-281
For use in Turkey 686318-141
For use in the United Kingdom and Singapore 686318-031
For use in the United States 686318-001

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models (includes keyboard
cable and pointing stick cable

For use only on computer models equipped with the Windows 8 operating system:

For use in Belgium 701987-A41
For use in Brazil 701987-201
For use in Bulgaria 701987-261
For use in Canada 701987-DB1
For use in the Czech Republic and Slovakia 701987FL1

For use in Denmark 701987-081
For use in France 701987-051
For use in Germany 701987-041
For use in Greece 701987-151
For use in Hungary 701987-211
For use in Iceland 701987-DD1
For use in India 701987-D61
For use in Israel 701987-BB1
For use in ltaly 701987-061
For use in Japan 701987-291
For use in Latin America 701987-161
For use in the Netherlands 701987-B31
For use in Norway 701987-091
For use in Northwest Africa 701987-FP1

For use in Portugal 701987-131
For use in Romania 701987-271
For use in Russia 701987-251
For use in Saudi Arabia 701987-171
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Item Component Spare part number
For use in Slovenia 701987-BA1
For use in South Korea 701987-AD1
For use in Spain 701987-071
For use in Sweden and Finland 701987-B71
For use in Switzerland 701987-BG1
For use in Taiwan 701987-AB1
For use in Thailand 701987-281
For use in Turkey 701987-141
For use in the United Kingdom and Singapore 701987031
For use in the United States 701987001
For use only on computer models equipped with the Windows 7 operating system:

For use in Belgium 690401-A41
For use in Brazil 690401-201
For use in Bulgaria 690401-261
For use in Canada 690401-DB1
For use in the Czech Republic and Slovakia 690401-FL1

For use in Denmark 690401-081
For use in France 690401-051
For use in Germany 690401-041
For use in Greece 690401-151
For use in Hungary 690401-211
For use in Iceland 690401-DD1
For use in India 690401-D61
For use in Israel 690401-BB1
For use in Italy 690401-061
For use in Japan 690401-291
For use in Latin America 690401-161
For use in the Netherlands 690401-B31
For use in Northwest Africa 690401-FP1

For use in Norway 690401-091
For use in Portugal 690401-131
For use in Romania 690401-271

Computer major components
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ltem Component Spare part number

For use in Russia 690401-251
For use in Saudi Arabia 690401-171
For use in Slovenia 690401-261
For use in South Korea 690401-AD1
For use in Spain 690401-071
For use in Sweden and Finland 690401871
For use in Switzerland 690401-BG1
For use in Taiwan 690401-AB1
For use in Thailand 690401-281
For use in Turkey 690401-141
For use in the United Kingdom and Singapore 690401-031
For use in the United States 690401-001

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models (includes
keyboard cable

For use only on computer models equipped with the Windows 8 operating system:

For use in Belgium 701988-A41
For use in Brazil 701988-201
For use in Bulgaria 701988261
For use in Canada 701988-DB1
For use in the Czech Republic and Slovakia 701988-FL1

For use in Denmark 701988081
For use in France 701988-051
For use in Germany 701988-041
For use in Greece 701988-151
For use in Hungary 701988-211
For use in Iceland 701988-DD1
For use in India 701988-D61
For use in Israel 701988-BB1
For use in ltaly 701988-061
For use in Japan 701988-291
For use in Latin America 701988-161
For use in the Netherlands 701988-B31
For use in Norway 701988-091
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Item Component Spare part number
For use in Northwest Africa 701988-FP1
For use in Portugal 701988-131
For use in Romania 701988-271
For use in Russia 701988-251
For use in Saudi Arabia 701988-171
For use in Slovenia 701988-BA1
For use in South Korea 701988-AD1
For use in Spain 701988-071
For use in Sweden and Finland 701988871
For use in Switzerland 701988-BG1
For use in Taiwan 701988-AB1
For use in Thailand 701988-281
For use in Turkey 701988-141
For use in the United Kingdom and Singapore 701988-031
For use in the United States 701988001
For use only on computer models equipped with the Windows 7 operating system:

For use in Belgium 690402-A41
For use in Brazil 690402-201
For use in Bulgaria 690402-261
For use in Canada 690402-DB1
For use in the Czech Republic and Slovakia 690402-FL1

For use in Denmark 690402081
For use in France 690402-051
For use in Germany 690402-041
For use in Hungary 690402-211
For use in Iceland 690402-DD1
For use in India 690402-D61
For use in Israel 690402-BB1
For use in Italy 690402-061
For use in Japan 690402-291
For use in Latin America 690402-161
For use in the Netherlands 690402-B31

Computer major components
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ltem Component Spare part number
For use in Northwest Africa 690402-FP1
For use in Norway 690402-091
For use in Portugal 690402-131
For use in Romania 690402-271
For use in Russia 690402-251
For use in Saudi Arabia 690402-171
For use in Slovenia 690402-261
For use in South Korea 690402-AD1
For use in Spain 690402-071
For use in Sweden and Finland 690402-B71
For use in Switzerland 690402BG1
For use in Taiwan 690402-AB1
For use in Thailand 690402-281
For use in Turkey 690402-141
For use in the United Kingdom and Singapore 690402031
For use in the United States 690402-001
(3) Top cover (includes TouchPad):
For use on HP EliteBook 8570p Notebook PC computer models:
Equipped with a pointing stick and a fingerprint reader 641207-001
Equipped with a pointing stick but not a fingerprint reader 641208-001
For use on HP EliteBook 6570b Notebook PC computer models:
Equipped with a pointing stick and a fingerprint reader 686316001
Equipped with a pointing stick but not a fingerprint reader 686317-001
(4) Fan (includes cable) 686311-001
(5) Heat sink (includes replacement thermal material):
For use only on computer models equipped with a graphics subsystem with 686310-001
discrete memory
For use only on computer models equipped with a graphics subsystem with 686309-001
UMA memory
(6) System board (includes replacement thermal material):
For use only on HP EliteBook 8570p Notebook PC computer models equipped with 686970-601

the QM77 chipset, a graphics subsystem with discrete memory, and the Windows 8
Professional operating system in all countries and regions except the People's Republic

of China and the Ukraine
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Item

Component Spare part number

For use only on HP EliteBook 8570p Notebook PC computer models equipped with 686970-501
the QM77 chipset, a graphics subsystem with discrete memory, and the Windows 8

Standard operating system in all countries and regions except the People's Republic of

China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with 686970-001
the QM77 chipset, a graphics subsystem with discrete memory, and the Windows 7

operating system in all countries and regions except the People's Republic of China

and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with 690021-601
the QM77 chipset, a graphics subsystem with discrete memory, and the Windows 8
Professional operating system only in the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with 690021-501
the QM77 chipset, a graphics subsystem with discrete memory, and the Windows 8
Standard operating system only in the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with 690021-001
the QM77 chipset, a graphics subsystem with discrete memory, and the Windows 7
operating system only in the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with 686971-601
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 8

Professional operating system in all countries and regions except the People's Republic

of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with 686971-501
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 8

Standard operating system in all countries and regions except the People's Republic of

China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with 686971-001
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 7

operating system in all countries and regions except the People's Republic of China

and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with 690022-601
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 8
Professional operating system only in the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with 690022-501
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 8
Standard operating system only in the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with 690022001
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 7
operating system only in the People's Republic of China and the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with 686976-601
the QM77 chipset, a graphics subsystem with discrete memory, WWAN capability,

and the Windows 8 Professional operating system in all countries and regions except

the People's Republic of China and the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with 686976-501
the QM77 chipset, a graphics subsystem with discrete memory, WWAN capability,

and the Windows 8 Standard operating system in all countries and regions except

the People's Republic of China and the Ukraine
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Item

Component

Spare part number

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, WWAN capability,
and the Windows 7 operating system in all countries and regions except the People's
Republic of China and the Ukraine

686976-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, WWAN capability,
and the Windows 8 Professional operating system only in the People's Republic of
China and the Ukraine

690027-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, WWAN capability,
and the Windows 8 Standard operating system only in the People's Republic of China
and the Ukraine

690027-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, WWAN capability,
and the Windows 7 operating system only in the People's Republic of China and
the Ukraine

690027-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with

the QM77 chipset, a graphics subsystem with UMA memory, WWAN capability, and
the Windows 8 Professional operating system in all countries and regions except

the People's Republic of China and the Ukraine

686974-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with

the QM77 chipset, a graphics subsystem with UMA memory, WWAN capability, and
the Windows 8 Standard operating system in all countries and regions except

the People's Republic of China and the Ukraine

686974-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with

the QM77 chipset, a graphics subsystem with UMA memory, WWAN capability, and
the Windows 7 operating system in all countries and regions except the People's
Republic of China and the Ukraine

686974-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with

the QM77 chipset, a graphics subsystem with UMA memory, WWAN capability, and
the Windows 8 Professional operating system only in the People's Republic of China
and the Ukraine

690025-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with

the QM77 chipset, a graphics subsystem with UMA memory, WWAN capability, and
the Windows 8 Standard operating system only in the People's Republic of China and
the Ukraine

690025-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with

the QM77 chipset, a graphics subsystem with UMA memory, WWAN capability, and
the Windows 7 operating system only in the People's Republic of China and

the Ukraine

690025-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with

the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 8
Professional operating system in all countries and regions except the People's Republic
of China and the Ukraine (includes replacement thermal material)

703887-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with

the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 8
Standard operating system in all countries and regions except the People's Republic of
China and the Ukraine (includes replacement thermal material)

703887-501
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Item

Component

Spare part number

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 7

operating system in all countries and regions except the People's Republic of China
and the Ukraine (includes replacement thermal material)

703887-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with discrete memory, WWAN capability,
and the Windows 8 Professional operating system in all countries and regions except
the People's Republic of China and the Ukraine

686975-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with

the HM76 chipset, a graphics subsystem with discrete memory, WWAN capability,
and the Windows 8 Standard operating system in all countries and regions except

the People's Republic of China and the Ukraine

686975-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with discrete memory, WWAN capability,
and the Windows 7 operating system in all countries and regions except the People's
Republic of China and the Ukraine

686975-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with discrete memory, WWAN capability,
and the Windows 8 Professional operating system only in the People's Republic of
China and the Ukraine

690026-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with discrete memory, WWAN capability,
and the Windows 8 Standard operating system only in the People's Republic of China
and the Ukraine

690026-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with discrete memory, WWAN capability,
and the Windows 7 operating system only in the People's Republic of China and
the Ukraine

690026-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, WWAN capability, and
the Windows 8 Professional operating system in all countries and regions except

the People's Republic of China and the Ukraine

686973-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, WWAN capability, and
the Windows 8 Standard operating system in all countries and regions except

the People's Republic of China and the Ukraine

686973-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, WWAN capability, and
the Windows 7 operating system in all countries and regions except the People's
Republic of China and the Ukraine

686973-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, WWAN capability, and
the Windows 8 Professional operating system only in the People's Republic of China
and the Ukraine

690024-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, WWAN capability, and
the Windows 8 Standard operating system only in the People's Republic of China and
the Ukraine

690024-501
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Item

Component

Spare part number

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, WWAN capability, and
the Windows 7 operating system only in the People's Republic of China and

the Ukraine

690024-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with

the HM76 chipset, a graphics subsystem with UMA memory, and the Windows 8
Professional operating system in all countries and regions except the People's Republic
of China and the Ukraine

686972-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with

the HM76 chipset, a graphics subsystem with UMA memory, and the Windows 8
Standard operating system in all countries and regions except the People's Republic of
China and the Ukraine

686972-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, and the Windows 7
operating system in all countries and regions except the People's Republic of China
and the Ukraine

686972-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, and the Windows 8
Professional operating system only in the People's Republic of China and the Ukraine

690023-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, and the Windows 8
Standard operating system only in the People's Republic of China and the Ukraine

690023-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, and the Windows 7
operating system only in the People's Republic of China and the Ukraine

690023-001

o))

Speaker assembly (includes cable)

641186-001

(®)

Processor (includes replacement thermal material):

Intel Quad Core i7-3740QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-
MHz FSB, 6.0-MB L3 cache, 45 W) for use only on HP EliteBook 8570p Notebook PC
computer models

702840-001

Intel Quad Core i7-3720QM 2.60-GHz processor (SC turbo up to 3.60-GHz; 1600-
MHz FSB, 6.0-MB L3 cache, 45 W) for use only on HP EliteBook 8570p Notebook PC
computer models

681283-001

Intel Quad Core i7-3630QM 2.40-GHz processor (SC turbo up to 3.40-GHz; 1600-
MHz FSB, 6.0-MB L3 cache, 45 W) for use only on HP EliteBook 8570p Notebook PC

computer models

702081-001

Intel Quad Core i7-3610QM 2.30-GHz processor (SC turbo up to 3.30-GHz; 1600-
MHz FSB, 6.0-MB L3 cache, 45 W) for use only on HP EliteBook 8570p Notebook PC

computer models

680646-001

Intel Dual Core i7-3540M 3.00-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz
FSB, 4.0-MB L3 cache, 45 W) for use on all computer models

710787-001

Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz
FSB, 4.0-MB L3 cache, 35 W) for use on all computer models

681954-001

Intel Dual Core i5-3380M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W) for use on all computer models

708762-001
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Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz  681953-001
FSB, 3.0-MB L3 cache, 35 W) for use on all computer models

Intel Dual Core i5-3340M 2.70-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz  708761-001
FSB, 3.0-MB L3 cache, 35 W) for use on all computer models

Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz ~ 681952-001
FSB, 3.0-MB L3 cache, 35 W) for use on all computer models

Intel Dual Core i5-3230M 2.60-GHz processor (SC turbo up to 3.20-GHz; 1600-MHz  711903-001
FSB, 3.0-MB L3 cache, 35 W) for use on all computer models

Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz ~ 680645-001
FSB, 3.0-MB L3 cache, 35 W) for use on all computer models

Intel Dual Core i3-3130M 2.60-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 713163-001
35 W) for use only on HP ProBook 6570b Notebook PC computer models

Intel Dual Core i3-3120M 2.50-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 700627-001
35 W) for use only on HP ProBook 6570b Notebook PC computer models

Intel Dual Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 682417-001
35 W) for use only on HP ProBook 6570b Notebook PC computer models

Intel Dual Core i3-2370M 2.40-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 677152-001
35 W) for use only on HP ProBook 6570b Notebook PC computer models

9) Modem module (does not include the modem module cable) 628824-001

NOTE: The modem module cable is included in the Cable Kits, spare part numbers
686308-001 (for use only on HP EliteBook 8570p Notebook PC computer models)
and 686307-001 (for use only on HP ProBook 6570b Notebook PC

computer models).

(10) Function board 686313001

(11) USB board 686314-001

(12) Base enclosure (includes rubber feet, service cover release latch assembly, and battery release latch assembly)
For use only on HP EliteBook 8570p Notebook PC computer models 641182001
For use only on HP ProBook 6570b Notebook PC computer models 644695-001

Rubber Kit (includes display bezel left and right rubber screw covers, base enclosure front and rear rubber screw
covers, fop cover rubber bumper):

For use only on HP EliteBook 8570p Notebook PC computer models 641192-001

For use only on HP ProBook 6570b Notebook PC computer models 646608-001

(13) Battery (Li ion):

9-cell, 100-Wh, 3.0-Ah 631243-001
9-cell, 73-Wh, 2.2-Ah 634089-001
6-cell, 62-Wh, 2.8-Ah 628668-001
6-cell, 55-Wh, 2.8-Ah 628670-001
3-cell, 31-Wh, 2.8-Ah 628664-001
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ltem Component Spare part number
(14) Bluetooth module 4.0 EDR (does not include the Bluetooth module cable) 655792001
NOTE: The Bluetooth module cable is included in the Cable Kits, spare part numbers
686308-001 (for use only on HP EliteBook 8570p Notebook PC computer models)
and 686307-001 (for use only on HP ProBook 6570b Notebook PC
computer models).
(15) Memory modules (2, PC3, 12800, 1600-MHz):
8-GB memory module 670034-001
8-GB memory module (PC3L) 693374-001
4-GB memory module 641369001
4-GB Samsung locked memory module 707031-001
2-GB memory module 652972-001
(16) WLAN module:
Atheros WB225 1x1 802.11b/g/n Bluetooth Combo Adapter 675794-001
Broadcom 43228 802.11abgn 2x2 Wi-Fi Adapter 669832-001
Intel Centrino Advanced-N 6205 WLAN module 631954001
Intel Centrino Ultimate-N 6300 WLAN module 572511-001
Intel Centrino Wireless-N 2200 802.11b/g/n 2x2 WiFi Adapter 670288-001
(17) WWAN module:
HP hs2350 HSPA+ Mobile Broadband Module 668969-001
HP 1t2523 LTE/HSPA+ Mobile Broadband Module 710790-001
HP 12522 LTE/EV-DO Mobile Broadband Module 710789-001
HP un2430 EV-DO/HSPA Mini Card 702080-001
HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001
(18) RTC battery 652650-001
(19) Optical drive (includes optical drive bezel and optical drive bracket)
Blu-ray ROM DVD+RW SuperMulti DL Drive for use only on HP EliteBook 8570p 690411-001
Notebook PC computer models (includes optical drive bezel and optical drive bracket)
DVD+RW Double-Layer with SuperMulti Drive for use only on HP EliteBook 8570p 690410-001
Notebook PC computer models (includes optical drive bezel and optical drive bracket)
DVD-ROM Drive for use only on HP EliteBook 8570p Notebook PC computer models ~ 690413-001
(includes optical drive bezel and optical drive bracket)
Blu-ray ROM DVD+RW SuperMulti DL Drive for use only on HP ProBook 6570b 690409-001
Notebook PC computer models (includes optical drive bezel and optical drive bracket)
DVD+RW Double-Layer with SuperMulti Drive for use only on HP ProBook 6570b 690408-001

Notebook PC computer models (includes optical drive bezel and optical drive bracket)
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DVD-ROM Drive for use only on HP ProBook 6570b Notebook PC computer models 690412-001

(includes optical drive bezel and optical drive bracket)

(20) Hard drive (does not include hard drive bracket or screws):
750-GB, 7200-rpm, 9.5-mm 633252-001
500-GB, 7200-rpm, 9.5-mm SED 683801-001
500-GB, 7200-rpm, 9.5-mm 634925-001
320-GB, 7200-rpm, 9.5-mm 634862-001

Hard Drive Hardware Kit (not illustrated, includes hard drive bracket and screws)  644694-001
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Item Component Spare part number
(1) Display bezel:
For use only on HP EliteBook 8570p Notebook PC computer models 686304-001
For use only on HP ProBook 6570b Notebook PC computer models 686303-001
(2) Display Hinge Kit:
For use only on HP EliteBook 8570p Notebook PC computer models (includes left and ~ 641193-001
right hinges, brackets, hinge covers, and hinge caps)
For use only on HP ProBook 6570b Notebook PC computer models (includes left and ~ 647677-001
right hinges and left and right hinge covers)
(3) 15.6-in, LED, AntiGlare display panel:
WVA, FHD, display panel 690405-001
WVA, HD+, display panel 690404-001
SVA, HD, display panel 690403-001
(4) Webcam/microphone module:
With keyboard light for use only on HP EliteBook 8570p Notebook PC 699688-001
computer models
Without keyboard light for use only on HP ProBook 6570b Notebook PC 699687-001
computer models
(5) Display panel cable (includes webcam/microphone module cable) 686898-001
For use only on HP EliteBook 8570p Notebook PC computer models equipped with an  686306-001
FHD or HD+ display assembly
For use only on HP EliteBook 8570p Notebook PC computer models equipped with an  686305-001
HD display assembly
For use only on HP ProBook 6570b Notebook PC computer models equipped with an  646970-001
FHD or HD+ display assembly
For use only on HP ProBook 6570b Notebook PC computer models equipped with an  646969-001
HD display assembly
(6) WWAN antenna cables and transceivers:
Available in the Cable Kit:
For use only on HP EliteBook 8570p Notebook PC computer models 686308-001
For use only on HP ProBook 6570b Notebook PC computer models 686307-001
Available in the Display Panel Support Kit:
For use only on HP EliteBook 8570p Notebook PC computer models 686312001
For use only on HP ProBook 6570b Notebook PC computer models 698942-001
(7) WLAN antenna cables and transceivers:
Available in the Cable Kit:
For use only on HP EliteBook 8570p Notebook PC computer models 686308-001

Display assembly subcomponents
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For use only on HP ProBook 6570b Notebook PC computer models 686307001

Available in the Display Panel Support Kit:

For use only on HP EliteBook 8570p Notebook PC computer models 686312-001

For use only on HP ProBook 6570b Notebook PC computer models 698942-001
(8) Display enclosure (included in the Display Panel Support Kit):

Display Panel Support Kit for use in HP EliteBook 8570p models (includes WLAN 686312001

antenna cables and transceivers, WWAN antenna cables and transceivers, and
display enclosure)

Display Panel Support Kit for use in HP ProBook 6570b models (includes WLAN 698942001
antenna cables and transceivers, WWAN antenna cables and transceivers, and
display enclosure)
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Item Component Spare part number
Cable Kit
For use only on HP EliteBook 8570p Notebook PC computer models 686308-001
For use only on HP ProBook 6570b Notebook PC computer models 686307-001
Includes:
(1) WWAN antenna transceivers and cables
(2) WLAN antenna transceivers and cables
(3) Multiple-input multiple-output (MIMO) antenna
(4) Power connector cable
(5) Bluetooth module cable
(6) RJ-11 jack cable
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Item Description Spare part number
) Hard drive (does not include hard drive bracket or screws):
750-GB, 7200-rpm, 9.5-mm 633252-001
500-GB, 7200-rpm, 9.5-mm SED 683801-001
500-GB, 7200-rpm, 9.5-mm 634925-001
320-GB, 7200-rpm, 9.5-mm 634862-001
Hard Drive Hardware Kit, includes: 644694-001
(2) Hard drive bracket
Hard drive bracket screws (not illustrated)
(3) Optical drive (includes optical drive bezel and optical drive bracket)
Blu-ray ROM DVD=RW SuperMulti DL Drive for use only on HP EliteBook 8570p 690411-001
Notebook PC computer models
DVD+RW Double-layer with SuperMulti Drive for use only on HP EliteBook 8570p 690410-001
Notebook PC computer models
DVD-ROM Dirive for use only on HP EliteBook 8570p Notebook PC computer models ~ 690413-001
Blu-ray ROM DVD+RW SuperMulti DL Drive for use only on HP ProBook 6570b 690409001

Notebook PC computer models
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Description Spare part number

DVD+RW Double-Layer with SuperMulti Drive for use only on HP ProBook 6570b 690408-001
Notebook PC computer models

DVD-ROM Drive for use only on HP ProBook 6570b Notebook PC computer models 690412-001

(4) Solid-state drive (does not include solid-state drive bracket or screws):
256-GB SED (for use only on HP EliteBook 8570p Notebook PC computer models) 690407-001
240-GB 702243-001
180-GB 700372-001
160-GB 693298-001
128-GB 690406-001

Plastics Kit
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Item Description Spare part number
Plastics Kit for use only on HP EliteBook 8570p Notebook PC computer models, 641190-001
includes:

(1) Service cover (includes “made in China” label)

(2) Optical drive bay space saver

(3) ExpressCard slot space saver

(4) Display assembly cable guide

Plastics Kit
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Item Description Spare part number
Plastics Kit for use only on HP EliteBook 6570b Notebook PC computer models, 646971001
includes:

(1) RJ-11 jack cover

(2) ExpressCard slot space saver

(3) Optical drive bay space saver

(4) Service cover (includes “made in China” label)

50 Chapter 3 lllustrated parts catalog



Miscellaneous parts

Component Spare part number

AC adapter:

90-W HP Smart AC adapter (PFC, EM, 3-wire) 693713-001
90-W HP Smart AC adapter (PFC, 3-wire) 693712001
65-W HP Smart AC adapter (non-PFC, 3-wire) 693711-001
65-W HP Smart AC adapter (RC/V, EM, 3-wire) 693710-001

Carrying case:

Professional top load slim case 592923-001
HP basic carrying case 455084-001
HP essential nylon case 612757001
HP essential top load case 679921-001
Notebook computer combination lock 591699-001

Optical mouse

HP USB optical travel mouse 434594-001

HP USB/PS2 2-button optical mouse 390632-001

Power cord (3-pin, black, 1.83-m):

For use in Argentina 490371-DO1
For use in Australia 490371-011
For use in Brazil 490371-202
For use in Denmark 490371081
For use in Europe 490371-021
For use in India 490371-D61
For use in Israel 490371-BB1
For use in Japan 490371-291
For use in North America 490371-001
For use in the People's Republic of China 490371-AA1
For use in South Africa 490371-AR1
For use in South Korea 490371-AD1
For use in Switzerland 490371-111
For use in Taiwan 490371-AB1
For use in Thailand 490371-201
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Component Spare part number

For use in the United Kingdom and Singapore 490371031
Screw Kit

For use only on HP EliteBook 8570p Notebook PC computer models 641191-001
For use only on HP ProBook 6570b Notebook PC computer models 646972001
Smart Card reader board (for use only on HP ProBook 6570b Notebook PC 686315001

computer models)

Sequential part number listing

Spare part number  Description

390632-001 HP USB/PS2 2-button optical mouse

434594-001 HP USB optical travel mouse

455084-001 HP basic carrying case

490371-001 Power cord for use on all computer models in North America (3-pin, black, 1.83-m)

490371011 Power cord for use on all computer models in Australia (3-pin, black, 1.83-m)

490371-021 Power cord for use on all computer models in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use on all computer models in the United Kingdom and Singapore (3-pin, black,
1.83-m)

490371081 Power cord for use on all computer models in Denmark (3-pin, black, 1.83-m)

490371-111 Power cord for use on all computer models in Switzerland (3-pin, black, 1.83-m)

490371-201 Power cord for use on all computer models in Thailand (3-pin, black, 1.83-m)

490371-202 Power cord for use on all computer models in Brazil (3-pin, black, 1.83-m)

490371-291 Power cord for use on all computer models in Japan (3-pin, black, 1.83-m)

490371-AA1 Power cord for use on all computer models in the People's Republic of China (3-pin, black, 1.83-m)

490371-AB1 Power cord for use on all computer models in Taiwan (3-pin, black, 1.83-m)

490371-AD1 Power cord for use on all computer models in South Korea (3-pin, black, 1.83-m)

490371-AR1 Power cord for use on all computer models in South Africa (3-pin, black, 1.83-m)

490371-BB1 Power cord for use on all computer models in Israel (3-pin, black, 1.83-m)

490371-D01 Power cord for use on all computer models in Argentina (3-pin, black, 1.83-m)

490371-D61 Power cord for use on all computer models in India (3-pin, black, 1.83-m)

572511-001 Intel Centrino Ultimate-N 6300 WLAN module

591699001 Notebook computer combination lock

592923001 Professional top load slim case
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Spare part number

Description

612757001 HP essential nylon case

628664-001 3-cell, 31-Wh, 2.80-Ah, Li-ion battery

628668-001 6-cell, 62-Wh, 2.80-Ah, Li-ion battery

628670-001 6-cell, 55-Wh, 2.80-Ah, Li-ion battery

628824-001 Modem module (does not include the modem module cable)

NOTE: The modem module cable is included in the Cable Kits, spare part numbers 686308-001
(for use only on HP EliteBook 8570p Notebook PC computer models) and 686307-001 (for use
only on HP ProBook 6570b Notebook PC computer models).

631243-001 9-cell, 100-Wh, 3.0-Ah, Li-ion battery

631954001 Intel Centrino Advanced-N 6205 WLAN module

633252-001 750-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 644694-001.

634089-001 6-cell, 73-Wh, 2.20-Ah, Li-ion battery

634400-001 HP un2430 EV-DO/HSPA Mobile Broadband Module

634862-001 320-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 644694-001.

634925-001 500-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 644694-001.

641182-001 Base enclosure for use only on HP EliteBook 8570p Notebook PC computer models (includes rubber
feet, service cover release latch assembly, and battery release latch assembly)

641186-001 Speaker assembly (includes cable)

641190001 Plastics Kit for use only on HP EliteBook 8570p Notebook PC computer models (includes service
cover with “made in China” label, optical drive bay space saver, ExpressCard bay space saver,
and wireless antenna cable covers)

641191001 Screw Kit for use only on HP EliteBook 8570p Notebook PC computer models

641192-001 Rubber Kit for use only on HP EliteBook 8570p Notebook PC computer models (includes display
bezel left and right rubber screw covers, base enclosure front and rear rubber screw covers, top
cover rubber bumper)

641193-001 Display Hinge Kit for use only on HP EliteBook 8570p Notebook PC computer models (includes left
and right hinges, brackets, hinge covers, and hinge caps)

641207001 Top cover for use only on HP EliteBook 8570p Notebook PC computer models equipped with a
pointing stick and a fingerprint reader (includes TouchPad)

641208-001 Top cover for use only on HP EliteBook 8570p Notebook PC computer models equipped with a
pointing stick but not a fingerprint reader (includes TouchPad)

641369-001 4-GB memory module (PC3, 12800, 1600-MHz)

Sequential part number listing
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Spare part number

Description

644694001 Hard Drive Hardware Kit (includes the hard drive bracket and screws)

644695001 Base enclosure for use only on HP ProBook 6570b Notebook PC computer models (includes rubber
feet, service cover release latch assembly, and battery release latch assembly)

646608-001 Rubber Kit for use only on HP ProBook 6570b Notebook PC computer models (includes display
bezel left and right rubber screw covers, base enclosure front and rear rubber screw covers, top
cover rubber bumper)

646969001 Display panel cable for use only on HP ProBook 6570b Notebook PC computer models equipped
with an HD display assembly (includes webcam/microphone module cable)

646970001 Display panel cable for use only on HP ProBook 6570b Notebook PC computer models equipped
with an FHD or HD+ display assembly (includes webcam/microphone module cable)

646971001 Plastics Kit for use only on HP ProBook 6570b Notebook PC computer models (includes service
cover with “made in China” label, optical drive bay space saver, ExpressCard bay space saver,
and RJ11 jack cover)

646972-001 Screw Kit for use only on HP ProBook 6570b Notebook PC computer models

647677001 Display Hinge Kit for use only on HP ProBook 6570b Notebook PC computer models (includes left
and right hinges and left and right hinge covers)

652650-001 RTC battery

652972001 2-GB memory module (PC3, 12800, 1600-MHz)

655792001 Bluetooth module 4.0 EDR (does not include the Bluetooth module cable)

NOTE: The Bluetooth module cable is included in the Cable Kits, spare part numbers
686308-001 (for use only on HP EliteBook 8570p Notebook PC computer models) and
686307-001 (for use only on HP ProBook 6570b Notebook PC computer models).

664663001 Intel Celeron B840 1.90-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, 35 W) for use only on
HP ProBook 6570b Notebook PC computer models (includes replacement thermal material)

668969-001 HP hs2350 HSPA+ Mobile Broadband Module

669832-001 Broadcom 43228 802.11abgn 2x2 Wi-Fi Adapter

670034-001 8-GB memory module (PC3, 12800, 1600-MHz)

670288-001 Intel Centrino Wireless-N 2200 802.11b/g/n 2x2 WiFi Adapter

670434001 Service cover (regional configure to order [RCTO] with “made in America” or “made in
Mexico” label)

671461001 Service cover (regional configure to order [RCTO] with “made in Japan” label)

675791-001 HP 12522 LTE/EV-DO Mobile Broadband Module

675793-001 HP 1t2523 LTE/HSPA+ Mobile Broadband Module

675794-001 Atheros WB225 1x1 802.11b/g/n Bluetooth Combo Adapter

677152001 Intel Dual Core i3-2370M 2.40-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) for use
only on HP ProBook 6570b Notebook PC computer models (includes replacement thermal material)

679921001 HP essential top load case
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Description

680645-001 Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W) for use on all computer models (includes replacement thermal material)

680646-001 Intel Quad Core i7-3610QM 2.30-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB, 6.0-
MB L3 cache, 45 W) for use only on HP EliteBook 8570p Notebook PC computer models (includes
replacement thermal material)

681283001 Intel Quad Core i7-3720QM 2.60-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 6.0-
MB L3 cache, 45 W) for use only on HP EliteBook 8570p Notebook PC computer models (includes
replacement thermal material)

681952-001 Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W) for use on all computer models (includes replacement thermal material)

681953-001 Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W) for use on all computer models (includes replacement thermal material)

681954-001 Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 4.0-MB
L3 cache, 35 W) for use on all computer models (includes replacement thermal material)

682417-001 Intel Dual Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) for use
on all computer models (includes replacement thermal material)

683801-001 500-GB, 7200-rpm, 9.5-mm SED hard drive (does not include hard drive bracket or screws)
NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 644694-001.

686302-001 Display enclosure for use only on HP EliteBook 8570p Notebook PC computer models

686303001 Display bezel for use only on HP ProBook 6570b Notebook PC computer models

686304-001 Display bezel for use only on HP EliteBook 8570p Notebook PC computer models

686305-001 Display panel cable for use only on HP EliteBook 8570p Notebook PC computer models equipped
with an HD display assembly

686306-001 Display panel cable for use only on HP EliteBook 8570p Notebook PC computer models equipped
with an FHD or HD+ display assembly

686307-001 Cable Kit for use only on HP ProBook 6570b Notebook PC computer models (includes Bluetooth
module cable, modem module cable, power connector cable, WLAN antenna cables, and WWAN
antenna cables)

686308-001 Cable Kit for use only on HP EliteBook 8570p Notebook PC computer models (includes Bluetooth
module cable, MIMO cable, modem module cable, power connector cable, WLAN antenna cables,
and WWAN antenna cables)

686309-001 Heat sink for use on computer models with a graphics subsystem with UMA memory (includes
replacement thermal material)

686310-001 Heat sink for use on computer models with a graphics subsystem with discrete memory (includes
replacement thermal material)

686311-001 Fan (includes cable)

686312-001 Display Panel Support Kit for use only on HP EliteBook 8570p Notebook PC computer models
(includes WLAN antenna cables and transceivers, WWAN antenna cables and transceivers, and
display enclosure)

686313-001 Function board

Sequential part number listing

55



56

Spare part number

Description

686314-001

USB board

686315-001

Smart Card reader board (for use only on HP ProBook 6570b Notebook PC computer models)

686316-001

Top cover for use only on HP ProBook 6570b Notebook PC computer models equipped with a
pointing stick and a fingerprint reader (includes TouchPad)

686317-001

Top cover for use only on HP ProBook 6570b Notebook PC computer models equipped with a
pointing stick but not a fingerprint reader (includes TouchPad)

686318-001

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in the United States (includes keyboard cable and
pointing stick cable)

686318-031

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in the United Kingdom and Singapore (includes
keyboard cable and pointing stick cable)

686318-041

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Germany (includes keyboard cable and pointing
stick cable)

686318-051

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in France (includes keyboard cable and pointing
stick cable)

686318-061

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in ltaly (includes keyboard cable and pointing
stick cable)

686318-071

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Spain (includes keyboard cable and pointing
stick cable)

686318081

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Denmark (includes keyboard cable and pointing
stick cable)

686318091

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Norway (includes keyboard cable and pointing
stick cable)

686318-131

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Portugal (includes keyboard cable and pointing
stick cable)

686318-141

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Turkey (includes keyboard cable and pointing
stick cable)

686318-151

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Greece (includes keyboard cable and pointing
stick cable)

686318-161

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Latin America (includes keyboard cable and
pointing stick cable)
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686318-171

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Saudi Arabia (includes keyboard cable and
pointing stick cable)

686318-201

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Brazil (includes keyboard cable and pointing
stick cable)

686318-211

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Hungary (includes keyboard cable and pointing
stick cable)

686318-251

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Russia (includes keyboard cable and pointing
stick cable)

686318-261

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Bulgaria (includes keyboard cable and pointing
stick cable)

686318-271

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Romania (includes keyboard cable and pointing
stick cable)

686318-281

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Thailand (includes keyboard cable and pointing
stick cable)

686318-291

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Japan (includes keyboard cable and pointing
stick cable)

686318-A41

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Belgium (includes keyboard cable and pointing
stick cable)

686318-AB1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Taiwan (includes keyboard cable and pointing
stick cable)

686318-AD1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in South Korea (includes keyboard cable and
pointing stick cable)

686318-B31

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in the Netherlands (includes keyboard cable and
pointing stick cable)

686318871

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Sweden and Finland (includes keyboard cable
and pointing stick cable)

686318-BA1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Slovenia (includes keyboard cable and pointing
stick cable)

686318-BB1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Israel (includes keyboard cable and pointing
stick cable)
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686318-BG1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Switzerland (includes keyboard cable and
pointing stick cable)

686318-D61

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in India (includes keyboard cable and pointing
stick cable)

686318-DB1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Canada (includes keyboard cable and pointing
stick cable)

686318-DD1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Iceland (includes keyboard cable and pointing
stick cable)

686318-FL1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in the Czech Republic and Slovakia (includes
keyboard cable and pointing stick cable)

686318-FP1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 7 operating system in Northwest Africa (includes keyboard cable and
pointing stick cable)

686970001

System board for use only on HP EliteBook 8570p Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, and the Windows 7 operating
system in all countries and regions except the People's Republic of China and the Ukraine (includes
replacement thermal material)

686970-501

System board for use only on HP EliteBook 8570p Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, and the Windows 8 Standard
operating system in all countries and regions except the People's Republic of China and the Ukraine
(includes replacement thermal material)

686970601

System board for use only on HP EliteBook 8570p Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, and the Windows 8 Professional
operating system in all countries and regions except the People's Republic of China and the Ukraine
(includes replacement thermal material)

686971-001

System board for use only on HP EliteBook 8570p Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 7 operating system
in all countries and regions except the People's Republic of China and the Ukraine (includes
replacement thermal material)

686971-501

System board for use only on HP EliteBook 8570p Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system in all countries and regions except the People's Republic of China and the Ukraine
(includes replacement thermal material)

686971-601

System board for use only on HP EliteBook 8570p Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system in all countries and regions except the People's Republic of China and the Ukraine
(includes replacement thermal material)

686972001

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, and the Windows 7 operating system
in all countries and regions except the People's Republic of China and the Ukraine (includes
replacement thermal material)
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686972-501

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system in all countries and regions except the People's Republic of China and the Ukraine
(includes replacement thermal material)

686972-601

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system in all countries and regions except the People's Republic of China and the Ukraine
(includes replacement thermal material)

686973-001

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, WWAN capability, and

the Windows 7 operating system in all countries and regions except the People's Republic of China
and the Ukraine (includes replacement thermal material)

686973-501

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, WWAN capability, and

the Windows 8 Standard operating system in all countries and regions except the People's Republic
of China and the Ukraine (includes replacement thermal material)

686973-601

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, WWAN capability, and

the Windows 8 Professional operating system in all countries and regions except the People's
Republic of China and the Ukraine (includes replacement thermal material)

686974-001

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, WWAN capability, and

the Windows 7 operating system in all countries and regions except the People's Republic of China
and the Ukraine (includes replacement thermal material)

686974-501

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, WWAN capability, and

the Windows 8 Standard operating system in all countries and regions except the People's Republic
of China and the Ukraine (includes replacement thermal material)

686974-601

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, WWAN capability, and

the Windows 8 Professional operating system in all countries and regions except the People's
Republic of China and the Ukraine (includes replacement thermal material)

686975-001

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with discrete memory, WWAN capability, and

the Windows 7 operating system in all countries and regions except the People's Republic of China
and the Ukraine (includes replacement thermal material)

686975-501

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with discrete memory, WWAN capability, and

the Windows 8 Standard operating system in all countries and regions except the People's Republic
of China and the Ukraine (includes replacement thermal material)

686975-601

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with discrete memory, WWAN capability, and

the Windows 8 Professional operating system in all countries and regions except the People's
Republic of China and the Ukraine (includes replacement thermal material)

686976-001

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, WWAN capability, and

the Windows 7 operating system in all countries and regions except the People's Republic of China
and the Ukraine (includes replacement thermal material)
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686976-501

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, WWAN capability, and

the Windows 8 Standard operating system in all countries and regions except the People's Republic
of China and the Ukraine (includes replacement thermal material)

686976-601

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, WWAN capability, and

the Windows 8 Professional operating system in all countries and regions except the People's
Republic of China and the Ukraine (includes replacement thermal material)

690021-001

System board for use only on HP EliteBook 8570p Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, and the Windows 7 operating
system only in the People's Republic of China and the Ukraine (includes replacement

thermal material)

690021-501

System board for use only on HP EliteBook 8570p Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, and the Windows 8 Standard
operating system only in the People's Republic of China and the Ukraine (includes replacement
thermal material)

690021-601

System board for use only on HP EliteBook 8570p Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, and the Windows 8 Professional
operating system only in the People's Republic of China and the Ukraine (includes replacement
thermal material)

690022-001

System board for use only on HP EliteBook 8570p Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 7 operating system
only in the People's Republic of China and the Ukraine (includes replacement thermal material)

690022-501

System board for use only on HP EliteBook 8570p Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system only in the People's Republic of China and the Ukraine (includes replacement
thermal material)

690022-601

System board for use only on HP EliteBook 8570p Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system only in the People's Republic of China and the Ukraine (includes replacement
thermal material)

690023-001

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, and the Windows 7 operating system
only in the People's Republic of China and the Ukraine (includes replacement thermal material)

690023-501

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system only in the People's Republic of China and the Ukraine (includes replacement
thermal material)

690023-601

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system only in the People's Republic of China and the Ukraine (includes replacement
thermal material)

690024-001

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, WWAN capability, and

the Windows 7 operating system only in the People's Republic of China and the Ukraine (includes
replacement thermal material)
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690024-501

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, WWAN capability, and

the Windows 8 Standard operating system only in the People's Republic of China and the Ukraine
(includes replacement thermal material)

690024-601

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with UMA memory, WWAN capability, and

the Windows 8 Professional operating system only in the People's Republic of China and

the Ukraine (includes replacement thermal material)

690025-001

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, WWAN capability, and

the Windows 7 operating system only in the People's Republic of China and the Ukraine (includes
replacement thermal material)

690025-501

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, WWAN capability, and

the Windows 8 Standard operating system only in the People's Republic of China and the Ukraine
(includes replacement thermal material)

690025-601

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, WWAN capability, and

the Windows 8 Professional operating system only in the People's Republic of China and

the Ukraine (includes replacement thermal material)

690026-001

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with discrete memory, WWAN capability, and

the Windows 7 operating system only in the People's Republic of China and the Ukraine (includes
replacement thermal material)

690026-501

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with discrete memory, WWAN capability, and

the Windows 8 Standard operating system only in the People's Republic of China and the Ukraine
(includes replacement thermal material)

690026-601

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the HM76 chipset, a graphics subsystem with discrete memory, WWAN capability, and

the Windows 8 Professional operating system only in the People's Republic of China and

the Ukraine (includes replacement thermal material)

690027-001

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, WWAN capability, and

the Windows 7 operating system only in the People's Republic of China and the Ukraine (includes
replacement thermal material)

690027-501

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, WWAN capability, and

the Windows 8 Standard operating system only in the People's Republic of China and the Ukraine
(includes replacement thermal material)

690027-601

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with discrete memory, WWAN capability, and

the Windows 8 Professional operating system only in the People's Republic of China and

the Ukraine (includes replacement thermal material)

690401-001

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in the United States (includes keyboard cable and
pointing stick cable)
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690401-031

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in the United Kingdom and Singapore (includes
keyboard cable and pointing stick cable)

690401-041

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Germany (includes keyboard cable and pointing
stick cable)

690401-051

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in France (includes keyboard cable and pointing
stick cable)

690401-061

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in ltaly (includes keyboard cable and pointing
stick cable)

690401-071

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Spain (includes keyboard cable and pointing
stick cable)

690401-081

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Denmark (includes keyboard cable and pointing
stick cable)

690401-091

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Norway (includes keyboard cable and pointing
stick cable)

690401-131

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Portugal (includes keyboard cable and pointing
stick cable)

690401-141

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Turkey (includes keyboard cable and pointing
stick cable)

690401-151

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Greece (includes keyboard cable and pointing
stick cable)

690401-161

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Latin America (includes keyboard cable and
pointing stick cable)

690401-171

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Saudi Arabia (includes keyboard cable and
pointing stick cable)

690401-201

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Brazil (includes keyboard cable and pointing
stick cable)

690401-211

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Hungary (includes keyboard cable and pointing
stick cable)

690401-251

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Russia (includes keyboard cable and pointing
stick cable)
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690401-261

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Bulgaria (includes keyboard cable and pointing
stick cable)

690401-271

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Romania (includes keyboard cable and pointing
stick cable)

690401-281

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Thailand (includes keyboard cable and pointing
stick cable)

690401-291

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Japan (includes keyboard cable and pointing
stick cable)

690401-A41

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Belgium (includes keyboard cable and pointing
stick cable)

690401-AB1

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Taiwan (includes keyboard cable and pointing
stick cable)

690401-AD1

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in South Korea (includes keyboard cable and
pointing stick cable)

690401-B31

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in the Netherlands (includes keyboard cable and
pointing stick cable)

690401-B71

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Sweden and Finland (includes keyboard cable
and pointing stick cable)

690401-BA1

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Slovenia (includes keyboard cable and pointing
stick cable)

690401-BB1

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Israel (includes keyboard cable and pointing
stick cable)

690401-BG1

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Switzerland (includes keyboard cable and
pointing stick cable)

690401-D61

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in India (includes keyboard cable and pointing
stick cable)

690401-DB1

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Canada (includes keyboard cable and pointing
stick cable)

690401-DD1

Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Iceland (includes keyboard cable and pointing
stick cable)
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690401-FL1 Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in the Czech Republic and Slovakia (includes
keyboard cable and pointing stick cable)
690401-FP1 Keyboard with pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Northwest Africa (includes keyboard cable and
pointing stick cable)
690402001 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in the United States (includes keyboard cable)
690402031 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in the United Kingdom and Singapore (includes
keyboard cable)
690402041 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Germany (includes keyboard cable)
690402051 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in France (includes keyboard cable)
690402-061 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in ltaly (includes keyboard cable)
690402-071 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Spain (includes keyboard cable)
690402-081 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Denmark (includes keyboard cable)
690402091 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Norway (includes keyboard cable)
690402-131 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Portugal (includes keyboard cable)
690402-141 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Turkey (includes keyboard cable)
690402-161 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Latin America (includes keyboard cable)
690402-171 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Saudi Arabia (includes keyboard cable)
690402-201 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Brazil (includes keyboard cable)
690402211 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Hungary (includes keyboard cable)
690402-251 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Russia (includes keyboard cable)
690402261 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Bulgaria (includes keyboard cable)
690402-271 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models

equipped with the Windows 7 operating system in Romania (includes keyboard cable)
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690402-281 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Thailand (includes keyboard cable)
690402-291 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Japan (includes keyboard cable)
690402-A41 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Belgium (includes keyboard cable)
690402-AB1 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Taiwan (includes keyboard cable)
690402-AD1 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in South Korea (includes keyboard cable)
690402-B31 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in the Netherlands (includes keyboard cable)
690402871 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Sweden and Finland (includes keyboard cable)
690402-BA1 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Slovenia (includes keyboard cable)
690402-BB1 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Israel (includes keyboard cable)
690402-BG1 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Switzerland (includes keyboard cable)
690402-D61 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in India (includes keyboard cable)
690402-DB1 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Canada (includes keyboard cable)
690402-DD1 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in Iceland (includes keyboard cable)
690402-FL1 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in the Czech Republic and Slovakia (includes
keyboard cable)
690402-FP1 Keyboard without pointing stick for use on HP ProBook 6570b Notebook PC computer models
equipped with the Windows 7 operating system in the Northwest Africa (includes keyboard cable)
690403-001 15.6-in, LED, SVA, HD, AntiGlare display panel
690404-001 15.6-in, LED, WVA, HD+, AntiGlare display panel
690405-001 15.6-in, LED, WVA, FHD, AntiGlare display panel
690406-001 128-GB solid-state drive (does not include bracket, connector cable, or screws)

NOTE: The bracket, connector cable, and screws are included in the Hard Drive Hardware Kit,
spare part number 644694-001.
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690407-001 256-GB solid-state drive SED (for use only on HP EliteBook 8570p Notebook PC computer models;

does not include bracket, connector cable, or screws)

NOTE: The bracket, connector cable, and screws are included in the Hard Drive Hardware Kit,
spare part number 644694-001.

690408-001 DVD=RW Double-layer with SuperMulti Drive for use only on HP ProBook 6570b Notebook PC
computer models (includes optical drive bezel and optical drive bracket)

690409001 Blu-ray ROM DVD=RW SuperMulti DL Drive for use only on HP ProBook 6570b Notebook PC
computer models (includes optical drive bezel and optical drive bracket)

690410001 DVD+RW Double-Layer with SuperMulti Drive for use only on HP EliteBook 8570p Notebook PC
computer models (includes optical drive bezel and optical drive bracket)

690411-001 Blu-ray ROM DVD+RW SuperMulti DL Drive for use only on HP EliteBook 8570p Notebook PC
computer models (includes optical drive bezel and optical drive bracket)

690412001 DVD-ROM Drive for use only on HP ProBook 6570b Notebook PC computer models (includes
optical drive bezel and optical drive bracket)

690413001 DVD-ROM Drive for use only on HP EliteBook 8570p Notebook PC computer models (includes
optical drive bezel and optical drive bracket)

693298-001 160-GB solid-state drive (does not include bracket, connector cable, or screws)

NOTE: The bracket, connector cable, and screws are included in the Hard Drive Hardware Kit,
spare part number 644694-001.

693374-001 8-GB memory module (PC3L, 12800, 1600-MHz)

693710-001 65-W HP Smart AC adapter (RC/V, EM, 3-wire)

693711-001 65-W HP Smart AC adapter (non-PFC, 3-wire)

693712001 90-W HP Smart AC adapter (PFC, 3-wire)

693713-001 90-W HP Smart AC adapter (PFC, EM, 3-wire)

698942001 Display Panel Support Kit for use only on HP ProBook 6570b Notebook PC computer models

(includes WLAN antenna cables and transceivers, WWAN antenna cables and transceivers, and
display enclosure)

699687001 Webcam/microphone module without keyboard light for use only on HP ProBook 6570b Notebook
PC computer models

699688001 Webcam/microphone module with a keyboard light for use only on HP EliteBook 8570p Notebook
PC computer models

700372-001 180-GB solid-state drive (does not include bracket, connector cable, or screws)

NOTE: The bracket, connector cable, and screws are included in the Hard Drive Hardware Kit,
spare part number 644694-001.

700627-001 Intel Dual Core i3-3120M 2.50-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) for use
only on HP ProBook 6570b Notebook PC computer models (includes replacement thermal material)

701986-001 Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in the United States (includes keyboard cable and
pointing stick cable)
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701986-031

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in the United Kingdom and Singapore (includes
keyboard cable and pointing stick cable)

701986-041

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Germany (includes keyboard cable and pointing
stick cable)

701986-051

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in France (includes keyboard cable and pointing
stick cable)

701986-061

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in ltaly (includes keyboard cable and pointing
stick cable)

701986-071

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Spain (includes keyboard cable and pointing
stick cable)

701986-081

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Denmark (includes keyboard cable and pointing
stick cable)

701986-091

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Norway (includes keyboard cable and pointing
stick cable)

701986-131

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Portugal (includes keyboard cable and pointing
stick cable)

701986-141

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Turkey (includes keyboard cable and pointing
stick cable)

701986-151

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Greece (includes keyboard cable and pointing
stick cable)

701986-161

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Latin America (includes keyboard cable and
pointing stick cable)

701986-171

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Saudi Arabia (includes keyboard cable and
pointing stick cable)

701986-201

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Brazil (includes keyboard cable and pointing
stick cable)

701986-211

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Hungary (includes keyboard cable and pointing
stick cable)

701986-251

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Russia (includes keyboard cable and pointing
stick cable)
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701986-261

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Bulgaria (includes keyboard cable and pointing
stick cable)

701986-271

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Romania (includes keyboard cable and pointing
stick cable)

701986-281

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Thailand (includes keyboard cable and pointing
stick cable)

701986-291

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Japan (includes keyboard cable and pointing
stick cable)

701986-A41

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Belgium (includes keyboard cable and pointing
stick cable)

701986-AB1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Taiwan (includes keyboard cable and pointing
stick cable)

701986-AD1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in South Korea (includes keyboard cable and
pointing stick cable)

701986-B31

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in the Netherlands (includes keyboard cable and
pointing stick cable)

701986-B71

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Sweden and Finland (includes keyboard cable
and pointing stick cable)

701986-BA1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Slovenia (includes keyboard cable and pointing
stick cable)

701986-BB1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Israel (includes keyboard cable and pointing
stick cable)

701986-BG1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Switzerland (includes keyboard cable and
pointing stick cable)

701986-D61

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in India (includes keyboard cable and pointing
stick cable)

701986-DB1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Canada (includes keyboard cable and pointing
stick cable)

701986-DD1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Iceland (includes keyboard cable and pointing
stick cable)
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701986-FL1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in the Czech Republic and Slovakia (includes
keyboard cable and pointing stick cable)

701986-FP1

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models
equipped with the Windows 8 operating system in Northwest Africa (includes keyboard cable and
pointing stick cable)

701987-001

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in the United States (includes keyboard cable and
pointing stick cable)

701987-031

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in the United Kingdom and Singapore (includes
keyboard cable and pointing stick cable)

701987-041

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Germany (includes keyboard cable and pointing
stick cable)

701987-051

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in France (includes keyboard cable and pointing
stick cable)

701987-061

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in ltaly (includes keyboard cable and pointing
stick cable)

701987-071

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Spain (includes keyboard cable and pointing
stick cable)

701987-081

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Denmark (includes keyboard cable and pointing
stick cable)

701987-091

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Norway (includes keyboard cable and pointing
stick cable)

701987-131

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Portugal (includes keyboard cable and pointing
stick cable)

701987-141

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Turkey (includes keyboard cable and pointing
stick cable)

701987-151

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Greece (includes keyboard cable and pointing
stick cable)

701987-161

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Latin America (includes keyboard cable and
pointing stick cable)

701987-171

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Saudi Arabia (includes keyboard cable and
pointing stick cable)
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701987-201

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Brazil (includes keyboard cable and pointing
stick cable)

701987-211

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Hungary (includes keyboard cable and pointing
stick cable)

701987-251

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Russia (includes keyboard cable and pointing
stick cable)

701987-261

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Bulgaria (includes keyboard cable and pointing
stick cable)

701987-271

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Romania (includes keyboard cable and pointing
stick cable)

701987-281

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Thailand (includes keyboard cable and pointing
stick cable)

701987-291

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Japan (includes keyboard cable and pointing
stick cable)

701987-A41

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Belgium (includes keyboard cable and pointing
stick cable)

701987-AB1

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Taiwan (includes keyboard cable and pointing
stick cable)

701987-AD1

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in South Korea (includes keyboard cable and
pointing stick cable)

701987-B31

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in the Netherlands (includes keyboard cable and
pointing stick cable)

701987-B71

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Sweden and Finland (includes keyboard cable
and pointing stick cable)

701987-BA1

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Slovenia (includes keyboard cable and pointing
stick cable)

701987-BB1

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Israel (includes keyboard cable and pointing
stick cable)

701987-BG1

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Switzerland (includes keyboard cable and
pointing stick cable)
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701987-D61

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in India (includes keyboard cable and pointing
stick cable)

701987-DB1

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Canada (includes keyboard cable and pointing
stick cable)

701987-DD1

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Iceland (includes keyboard cable and pointing
stick cable)

701987-FL1

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in the Czech Republic and Slovakia (includes
keyboard cable and pointing stick cable)

701987-FP1

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Northwest Africa (includes keyboard cable and
pointing stick cable)

701988-001

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in the United States (includes keyboard cable)

701988-031

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in the United Kingdom and Singapore (includes
keyboard cable)

701988-041

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Germany (includes keyboard cable)

701988-051

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in France (includes keyboard cable)

701988-061

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in ltaly (includes keyboard cable)

701988-071

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Spain (includes keyboard cable)

701988-081

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Denmark (includes keyboard cable)

701988-091

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Norway (includes keyboard cable)

701988-131

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Portugal (includes keyboard cable)

701988-141

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Turkey (includes keyboard cable)

701988-161

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Latin America (includes keyboard cable)

701988-171

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Saudi Arabia (includes keyboard cable)

701988-201

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Brazil (includes keyboard cable)
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701988-211 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Hungary (includes keyboard cable)

701988-251 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Russia (includes keyboard cable)

701988-261 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Bulgaria (includes keyboard cable)

701988271 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Romania (includes keyboard cable)

701988-281 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Thailand (includes keyboard cable)

701988-291 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Japan (includes keyboard cable)

701988-A41 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Belgium (includes keyboard cable)

701988-AB1 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Taiwan (includes keyboard cable)

701988-AD1 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in South Korea (includes keyboard cable)

701988-B31 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in the Netherlands (includes keyboard cable)

701988-B71 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Sweden and Finland (includes keyboard cable)

701988-BA1 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Slovenia (includes keyboard cable)

701988-BB1 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Israel (includes keyboard cable)

701988-BG1 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Switzerland (includes keyboard cable)

701988-D61 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in India (includes keyboard cable)

701988-DB1 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Canada (includes keyboard cable)

701988-DD1 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Iceland (includes keyboard cable)

701988-FL1 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in the Czech Republic and Slovakia (includes
keyboard cable)

701988-FP1 Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models
equipped with the Windows 8 operating system in Northwest Africa (includes keyboard cable)

702080-001 HP un2430 EV-DO/HSPA Mini Card
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702081-001

Intel Quad Core i7-3630QM 2.40-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz FSB, 6.0-
MB L3 cache, 45 W) for use only on HP EliteBook 8570p Notebook PC computer models (includes
replacement thermal material)

702243-001

240-GB solid-state drive (does not include bracket, connector cable, or screws)

NOTE: The bracket, connector cable, and screws are included in the Hard Drive Hardware Kit,
spare part number 644694-001.

702840-001

Intel Quad Core i7-3740QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 6.0-
MB L3 cache, 45 W) for use only on HP EliteBook 8570p Notebook PC computer models (includes
replacement thermal material)

703887-001

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 7 operating system
in all countries and regions except the People's Republic of China and the Ukraine (includes
replacement thermal material)

703887-501

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system in all countries and regions except the People's Republic of China and the Ukraine
(includes replacement thermal material)

703887-601

System board for use only on HP ProBook 6570b Notebook PC computer models equipped with
the QM77 chipset, a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system in all countries and regions except the People's Republic of China and the Ukraine
(includes replacement thermal material)

707031-001

4-GB Samsung locked memory module (PC3, 12800, 1600-MHz)

708761-001

Intel Dual Core i5-3340M 2.70-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W) for use on all computer models (includes replacement thermal material)

708762-001

Intel Dual Core i5-3380M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 3.0-MB

L3 cache, 35 W) for use on all computer models (includes replacement thermal material)

710787-001

Intel Dual Core i7-3540M 3.00-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 4.0-MB

L3 cache, 45 W) for use on all computer models (includes replacement thermal material)

710789-001

HP 1t2522 LTE/EV-DO Mobile Broadband Module

710790-001

HP [t2523 LTE/HSPA+ Mobile Broadband Module

711903-001

Intel Dual Core i5-3230M 2.60-GHz processor (SC turbo up to 3.20-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W) for use on all computer models (includes replacement thermal material)

713163-001

Intel Dual Core i3-3130M 2.60-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) for use
on all computer models (includes replacement thermal material)
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
¢  Flatbladed screwdriver
®  Magnetic screwdriver

e  Phillips PO and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

@NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/\ CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in
the maintenance instructions.

Cables and connectors

/\ CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.
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Drive handling

/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether
the computer is off or in Hibernation, turn the computer on, and then shut it down through
the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
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/\ CAUTION: To prevent damage to the computer when you are removing or installing internal

components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described

in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by

different activities.

/\ CAUTION: A product can be degraded by as litlle as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800 V 400 V
Removing DIPS from plastic tube 2,000V 700V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at staticfree workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
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Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm +10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastics Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000V
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Component replacement procedures

This chapter provides removal and replacement procedures.
There are as many as 94 screws that must be removed, replaced, and/or loosened when servicing

the computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 81 for battery removal instructions.

[ [//] 00000000
O Serial: J0000000C I IWAN WA
8:—Pmduct 000000 [IMENmEMEInENEIN

L Warranty: 1y1yOy

N

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.
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Item Component Description

(3) Part number/Product number (p/n) This number provides specific information about
the product’s hardware components. The part number
helps a service technician determine what components
and paris are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kits, spare
part numbers 641192-001 (for use only on HP EliteBook 8570p Notebook PC computer models) and
646608-001 (for use only on HP ProBook 6570b Notebook PC computer models). There are 4
rectangular rubber feet (1) and one square rubber foot (2) that attach to the base enclosure and
service cover in the locations illustrated below.
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Battery

Description Spare part number
9-cell, 100-Wh, 3.0-Ah 631243-001
9-cell, 73-Wh, 2.2-Ah 634089-001
6-cell, 62-Wh, 2.8-Ah 628668-001
6-cell, 55-Wh, 2.8-Ah 628670-001
3-cell, 31-Wh, 2.8-Ah 628664-001

Before disassembling the computer, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

Remove the battery:

1. Position the computer upside-down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM

Before removing the SIM, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 81).

Remove the SIM:
1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)
2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.

82 Chapter 4 Removal and replacement procedures



Service cover

r__f'%NOTE: The service cover is included in the Plastics Kit, spare part numbers 641190-001 (for use only
on HP EliteBook 8570p Notebook PC computer models) and 646971-001 (for use only on HP
EliteBook 6570B Notebook PC computer models). The service cover included in the Plastics Kits
includes a “made in China” label.

The service cover is also available using the following spare part numbers for regional configure to
order (RCTO) circumstances:

e 670434-001—regional configure to order (RCTO) with “made in America” or “made in Mexico”
label

e 671461-001—RCTO with “made in Japan” label
Before removing the service cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 81).

Remove the service cover:
1. Slide the release latch (1) and remove the locking screw (if installed) (2).
2. Slide the release latch (3) to disengage the door from the computer.

3. Slide the door toward the front of the computer (4), and then lift the door off the computer (5).
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Reverse the removal procedures to install the service cover.

Optical drive

Description Spare part number

Blu-ray ROM DVD+RW SuperMulti DL Drive for use only on HP EliteBook 8570p Notebook PC 690411-001
computer models (includes optical drive bezel and optical drive bracket)

DVD+RW Double-Layer with SuperMulti Drive for use only on HP EliteBook 8570p Notebook PC 690410-001
computer models (includes optical drive bezel and optical drive bracket)

DVD-ROM Drive for use only on HP EliteBook 8570p Notebook PC computer models (includes 690413-001
optical drive bezel and optical drive bracket)

Blu-ray ROM DVD+RW SuperMulti DL Drive for use only on HP ProBook 6570b Notebook PC 690409-001
computer models (includes optical drive bezel and optical drive bracket)

DVD+RW Double-Layer with SuperMulti Drive for use only on HP ProBook 6570b Notebook PC 690408-001
computer models (includes optical drive bezel and optical drive bracket)

DVD-ROM Drive for use only on HP ProBook 6570b Notebook PC computer models (includes 690412-001
optical drive bezel and optical drive bracket)

Before removing the optical drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

Remove the battery (see Battery on page 81).

2,
3. Disconnect all external devices from the computer.
4.
5.

Remove the service cover (see Service cover on page 83).

Remove the optical drive:
1. Position the computer upside-down with the right side toward you.
2. Loosen the captive Phillips screw (1) that secures the optical drive to the computer.

3. Use a flat-blade screw driver or similar tool to press on the optical drive bracket tab (2) to release
the optical drive.
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4. Remove the optical drive (3) from the computer.

5. Ifitis necessary fo replace the optical drive bezel, use a thin tool or an unbent paper clip (1) to
release the optical drive tray.

6. Use a flat-blade screw driver or similar tool to press on the optical drive bezel tab (2), and then
release the left side of the optical drive bezel (3).

7. Remove the optical drive bezel (4).

8. [Ifitis necessary fo replace the optical drive bracket, position the optical drive with the rear panel
toward you.

9. Remove the three Phillips PM2.0x3.0 screws (1) that secure the optical drive bracket to
the optical drive.
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10. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.

Upgrade bay

Before removing the upgrade bay, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.
Disconnect all external devices from the computer.

Remove the battery (see Battery on page 81).

2
3.
4
5

Remove the service cover (see Service cover on page 83).

Remove the upgrade bay:
1. Position the computer upside-down with the right side toward you.

2. Remove the four Phillips PM2.0x4.0 screws that secure the upgrade bay assembly to
the computer.
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3. Lloosen the captive Phillips screw that secures the upgrade bay drive in the upgrade bay (1).

4. Use a flat-blade screw driver or similar tool to press on the upgrade bay bracket tab (2) to release

the upgrade bay.

5. Remove the upgrade bay (3) from the computer.

Reverse this procedure to install the upgrade bay.

Hard drive

E%NOTE: The hard drive spare part kit does not include the hard drive bracket or screws.

Description Spare part number
750-GB, 7200-rpm, 9.5-mm 633252-001
500-GB, 7200-rpm, 9.5-mm SED 683801-001
500-GB, 7200-rpm, 9.5-mm 634925-001
320-GB, 7200-rpm, 9.5-mm 634862-001
Hard Drive Hardware Kit (includes hard drive bracket and screws) 644694001

Before removing the hard drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

.

Disconnect all external devices from the computer.

Remove the battery (see Battery on page 81).

aua ~ O N

)

Remove the service cover (see Service cover on page 83).
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Remove the hard drive:
1. Loosen the three Phillips screws (1) that secure the hard drive to the computer.

2. Use the hard drive tab (2) to slide the hard drive to the right to disconnect it from the system
board.

3. Remove the hard drive (3) from the hard drive bay.

4. Ifitis necessary to disassemble the hard drive, perform the following steps:

a. Remove the four Phillips PM3.0x3.0 screws (1) that secure the hard drive bracket to
the hard drive.

b. Remove the hard drive bracket (2) from the hard drive. The hard drive bracket and screws
are available in the Hard Drive Hardware Kit, spare part number 644694-001.
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Reverse this procedure to reassemble and install the hard drive.

RTC battery

Description Spare part number

RTC battery (includes cable and double-sided tape) 652650001

Before removing the RTC battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.
Disconnect all external devices from the computer.

Remove the battery (see Battery on page 81).

A

Remove the service cover (see Service cover on page 83).

Remove the RTC battery:
1. Disconnect the RTC battery cable (1) from the system board.

2. Detach the RTC battery (2) from the base enclosure. (The RTC battery is attached to
the base enclosure with double-sided tape.)

3. Remove the RTC battery.

Reverse this procedure to install the RTC battery.
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Memory module
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@NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom of
the computer.

Description Spare part number
8-GB memory module (PC3, 12800, 1600-MHz) 670034-001
8-GB memory module (PC3L, 12800, 1600-MHz) 693374-001
4-GB memory module (PC3, 12800, 1600-MHz) 641369-001
4-GB Samsung locked memory module (PC3, 12800, 1600-MHz) 707031-001
2-GB memory module (PC3, 12800, 1600-MHz) 652972-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

/\ CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1.
2.
3.

4
5
6.
7
8

Navigate to www.hp.com.
Click Support & Drivers > click Drivers & Software.

In the Enter a product name/number box, type the computer model information, and then
click Search.

Click the link for the computer model.

Select the operating system, and then click Next.

Under Step 2: Select a Download, click the BIOS link.
Click the link for the most recent BIOS.

Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:

1.

LA

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.
Disconnect all external devices from the computer.

Remove the battery (see Battery on page 81).

Remove the service cover (see Service cover on page 83).
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Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

2. Remove the memory module (2) by pulling the module away from the slot at an angle.

%NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into
the memory module slot.

%NOTE: The computer uses two memory slots. The top slot houses the expansion memory module
and is shown in the first image below. The bottom slot houses the primary memory module and is
shown in the second image below.

Reverse this procedure to install a memory module.
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WWAN module

@NOTE: The WWAN module and the WLAN module are not interchangeable.

92

Description Spare part number
HP hs2350 HSPA+ Mobile Broadband Module 668969001
HP 12523 LTE/HSPA+ Mobile Broadband Module 710790-001
HP 12522 LTE/EV-DO Mobile Broadband Module 710789-001
HP un2430 EV-DO/HSPA Mini Card 702080-001
HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

Before removing the WWAN module, follow these steps:

1.

2
3.
4
5

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.
Disconnect all external devices from the computer.

Remove the battery (see Battery on page 81).

Remove the service cover (see Service cover on page 83).

Remove the WWAN module:

1.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

E’%NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.

2.

The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

Remove the two Phillips PM2.0x3.0 screws (2) that secure the WLAN module to

the base enclosure. (The WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

E%’NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

@NOTE: If the WWAN antennas are not connected to the terminals on the WWAN module,
the protective sleeves must be installed on the antenna connectors, as shown in the following

illustration.
J /\
-~
7

Reverse this procedure to install the WWAN module.

H
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WLAN module
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Description Spare part number
HP hs2350 HSPA+ Mobile Broadband Module 668969001
HP [t2523 LTE/HSPA+ Mobile Broadband Module 710790-001
HP 12522 LTE/EV-DO Mobile Broadband Module 710789-001
HP un2430 EV-DO/HSPA Mini Card 702080-001
HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

/\ CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove
the module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1.

2
3.
q
5

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.
Disconnect all external devices from the computer.

Remove the battery (see Battery on page 81).

Remove the service cover (see Service cover on page 83).

Remove the WLAN module:

1.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

E%fNOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal

labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellow
WILAN antenna cable connects to the middle terminal on the WLAN module.

Remove the two Phillips PM2.0x3.0 screws (2) that secure the WLAN module to
the base enclosure. (The WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

@NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

E"jNOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Bluetooth module

@NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kits, spare part numbers 686308-001 (for use only on HP
EliteBook 8570p Notebook PC computer models) and 686307-001 (for use only on HP ProBook
6570b Notebook PC computer models).

Description Spare part number

Bluetooth module 4.0 EDR 655792-001

Before removing the Bluetooth module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

Remove the battery (see Battery on page 81).

2
3. Disconnect all external devices from the computer.
4
5

Remove the service cover (see Service cover on page 83).

Remove the Bluetooth module:

1. Release the Bluetooth module (1) from the clip built into the base enclosure.
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2. Disconnect the Bluetooth module cable (2) from the Bluetooth module.

3. Remove the Bluetooth module.

Reverse this procedure to install the Bluetooth module.
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Modem module

@NOTE: The modem module spare part kit does not include a RJ-11 jack cable. The RJ-11 jack cable is
included in the Cable Kits, spare part numbers 686308-001 (for use only on HP EliteBook 8570p
Notebook PC computer models) and 686307-001 (for use only on HP ProBook 6570b Notebook PC
computer models).

Description Spare part number

Modem module 628824-001

Before removing the modem module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

Remove the battery (see Battery on page 81).

2
3. Disconnect all external devices from the computer.
4
5

Remove the service cover (see Service cover on page 83).

Remove the modem module:
1. Remove the Phillips PM2.0x3.0 screw (1) that secures the modem module to the system board.

2. Disconnect the modem module (2) from the system board by lifting it straight up.

98 Chapter 4 Removal and replacement procedures



3. Disconnect the modem module cable (3) from the modem module.

4. Remove the modem module.

Reverse this procedure to install the modem module.
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Fan

Description Spare part number

Fan (includes cable) 686311001

Before removing the fan, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

Disconnect all external devices from the computer.

2
3
4. Remove the battery (see Battery on page 81).
5

Remove the service cover (see Service cover on page 83).

Remove the fan:
1. Disconnect the fan cable (1) from the system board.

2. Loosen the three captive Phillips screws (2) that secure the fan to the base enclosure.

3. Remove the fan (3).

Reverse this procedure to install the fan.
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Keyboard

For use in country/region Spare part
number

For use in country/region

Spare part
number

Keyboard with pointing stick for use on HP EliteBook 8570p Notebook PC computer models (includes keyboard cable and

pointing stick cable):

For use only on computer models equipped with For use in the Netherlands 701986-B31
the Windows 8 operating system:

For use in Belgium 701986-A41 For use in Norway 701986-091
For use in Brazil 701986-201 For use in Northwest Africa 701986-FP1
For use in Bulgaria 701986-261 For use in Portugal 701986-131
For use in Canada 701986-DB1 For use in Romania 701986-271
For use in the Czech Republic 701986-FL1 For use in Russia 701986251
and Slovakia

For use in Denmark 701986-081 For use in Saudi Arabia 701986-171
For use in France 701986-051 For use in Slovenia 701986-BA1
For use in Germany 701986-041 For use in South Korea 701986-AD1
For use in Greece 701986-151 For use in Spain 701986-071
For use in Hungary 701986-211 For use in Sweden and Finland 701986-B71
For use in Iceland 701986-DD1 For use in Switzerland 701986BG1
For use in India 701986-D61 For use in Taiwan 701986-AB1
For use in Israel 701986-BB1 For use in Thailand 701986-281
For use in ltaly 701986-061 For use in Turkey 701986-141
For use in Japan 701986-291 For use in the United Kingdom 701986031

and Singapore

For use in Latin America 701986-161 For use in the United States 701986001
For use only on computer models equipped with For use in the Netherlands 686318831
the Windows 7 operating system:

For use in Belgium 686318-A41 For use in Northwest Africa 686318-FP1
For use in Brazil 686318-201 For use in Norway 686318-091
For use in Bulgaria 686318-261 For use in Portugal 686318-131
For use in Canada 686318-DB1 For use in Romania 686318-271
For use in the Czech Republic 686318-FL1 For use in Russia 686318-251
and Slovakia

For use in Denmark 686318-081 For use in Saudi Arabia 686318-171
For use in France 686318-051 For use in Slovenia 686318-261
For use in Germany 686318-041 For use in South Korea 686318-AD1
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For use in country/region Spare part For use in country/region Spare part

number number
For use in Greece 686318-151 For use in Spain 686318-071
For use in Hungary 686318211 For use in Sweden and Finland 686318871
For use in Iceland 686318-DD1 For use in Switzerland 686318-BG1
For use in India 686318-D61 For use in Taiwan 686318-AB1
For use in Israel 686318-BB1 For use in Thailand 686318-281
For use in Italy 686318061 For use in Turkey 686318-141
For use in Japan 686318291 For use in the United Kingdom 686318031

and Singapore

For use in Latin America 686318-161 For use in the United States 686318-001

Keyboard with pointing stick for use on HP EliteBook 6570b Notebook PC computer models (includes keyboard cable and
pointing stick cable):

For use only on computer models equipped with For use in the Netherlands 701987-B31
the Windows 8 operating system:

For use in Belgium 701987-A41 For use in Norway 701987-091
For use in Brazil 701987-201 For use in Northwest Africa 701987-FP1
For use in Bulgaria 701987-261 For use in Portugal 701987-131
For use in Canada 701987-DB1 For use in Romania 701987-271
For use in the Czech Republic 701987-FL1 For use in Russia 701987-251
and Slovakia

For use in Denmark 701987081 For use in Saudi Arabia 701987-171
For use in France 701987051 For use in Slovenia 701987-BA1
For use in Germany 701987-041 For use in South Korea 701987-AD1
For use in Greece 701987-151 For use in Spain 701987-071
For use in Hungary 701987211 For use in Sweden and Finland 701987-871
For use in Iceland 701987-DD1 For use in Switzerland 701987-BG1
For use in India 701987-D61 For use in Taiwan 701987-AB1
For use in Israel 701987-BB1 For use in Thailand 701987-281
For use in Italy 701987-061 For use in Turkey 701987-141
For use in Japan 701987-291 For use in the United Kingdom 701987031

and Singapore

For use in Latin America 701987-161 For use in the United States 701987-001
For use only on computer models equipped with For use in the Netherlands 690401-B31

the Windows 7 operating system:

For use in Belgium 690401-A41 For use in Northwest Africa 690401-FP1
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For use in country/region Spare part For use in country/region Spare part
number number

For use in Brazil 690401-201 For use in Norway 690401-091
For use in Bulgaria 690401-261 For use in Portugal 690401-131
For use in Canada 690401-DB1 For use in Romania 690401-271
For use in the Czech Republic 690401-FL1 For use in Russia 690401-251
and Slovakia

For use in Denmark 690401-081 For use in Saudi Arabia 690401-171
For use in France 690401-051 For use in Slovenia 690401-261
For use in Germany 690401-041 For use in South Korea 690401-AD1
For use in Greece 690401-151 For use in Spain 690401-071
For use in Hungary 690401-211 For use in Sweden and Finland 690401871
For use in Iceland 690401-DD1 For use in Switzerland 690401-BG1
For use in India 690401-D61 For use in Taiwan 690401-AB1
For use in Israel 690401-BB1 For use in Thailand 690401-281
For use in ltaly 690401-061 For use in Turkey 690401-141
For use in Japan 690401-291 For use in the United Kingdom 690401-031

and Singapore

For use in Latin America 690401-161 For use in the United States 690401-001

Keyboard without pointing stick for use on HP EliteBook 6570b Notebook PC computer models (includes keyboard cable):

For use only on computer models equipped with For use in the Netherlands 701988831
the Windows 8 operating system:

For use in Belgium 701988A41 For use in Norway 701988-091
For use in Brazil 701988-201 For use in Northwest Africa 701988-FP1
For use in Bulgaria 701988-261 For use in Portugal 701988-131
For use in Canada 701988-DB1 For use in Romania 701988-271
For use in the Czech Republic 701988-FL1 For use in Russia 701988-251
and Slovakia

For use in Denmark 701988-081 For use in Saudi Arabia 701988-171
For use in France 701988-051 For use in Slovenia 701988-BA1
For use in Germany 701988-041 For use in South Korea 701988-AD1
For use in Greece 701988-151 For use in Spain 701988-071
For use in Hungary 701988-211 For use in Sweden and Finland 701988-B71
For use in Iceland 701988-DD1 For use in Switzerland 701988-BG1
For use in India 701988-D61 For use in Taiwan 701988-AB1
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For use in country/region Spare part For use in country/region Spare part
number number
For use in Israel 701988BB1 For use in Thailand 701988-281
For use in ltaly 701988-061 For use in Turkey 701988-141
For use in Japan 701988291 For use in the United Kingdom 701988031
and Singapore

For use in Latin America 701988-161 For use in the United States 701988-001
For use only on computer models equipped with For use in the Netherlands 690402-B31
the Windows 7 operating system:

For use in Belgium 690402-A41 For use in Northwest Africa 690402-FP1
For use in Brazil 690402-201 For use in Norway 690402-091
For use in Bulgaria 690402-261 For use in Portugal 690402-131
For use in Canada 690402-DB1 For use in Romania 690402-271
For use in the Czech Republic 690402-FL1 For use in Russia 690402-251
and Slovakia

For use in Denmark 690402081 For use in Saudi Arabia 690402-171
For use in France 690402-051 For use in Slovenia 690402-261
For use in Germany 690402-041 For use in South Korea 690402-AD1
For use in Hungary 690402-211 For use in Spain 690402-071
For use in Iceland 690402-DD1 For use in Sweden and Finland 690402-871
For use in India 690402-D61 For use in Switzerland 690402-BG1
For use in Israel 690402-BB1 For use in Taiwan 690402-AB1
For use in Italy 690402-061 For use in Thailand 690402-281
For use in Japan 690402-291 For use in Turkey 690402-141
For use in Latin America 690402-161 For use in the United Kingdom 690402031

and Singapore
For use in the Netherlands 690402-131 For use in the United States 690402-001

Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

aua &~ WO DN

Remove the battery (see Battery on page 81).

Disconnect all external devices from the computer.

Chapter 4 Removal and replacement procedures

. Remove the service cover (see Hard drive on page 87).

Disconnect the power from the computer by unplugging the power cord from the computer.



Remove the keyboard:

1. Loosen the three Phillips captive screws that secure the keyboard to the computer.

2. Rest and secure the computer on its right side.
3. Partially open the computer.

4. Insert a screw driver or similar thin tool into the keyboard release hole, and then press on the back
of the keyboard until the keyboard disengages from the computer.

5. Turn the computer rightside up with the front foward you.
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6. Llift the rear edge of the keyboard (1), and then swing the keyboard up and forward (2) until it
rests upside down on the palm rest.

r__f"%NOTE: The pointing stick cable is present on select models only.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
then disconnect the keyboard cable (2) from the system board.

8. Release the ZIF connector (3) to which the pointing stick cable is attached, and then disconnect
the pointing stick cable (4) from the system board.

9. Remove the keyboard.

Reverse this procedure fo install the keyboard.
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Base enclosure

E’%NOTE: The base enclosure spare part kit includes four rubber feet, the service cover release latch
assembly, and the battery release latch assembly.

Description Spare part number
For use only on HP EliteBook 8570p Notebook PC computer models 641182-001
For use only on HP ProBook 6570b Notebook PC computer models 644695-001

E%NOTE: When replacing the base enclosure, remove the modem cover from the slot in the base
enclosure of if the repaired unit includes a modem module.

Before removing the base enclosure, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 81), and then remove the following components:

a. Service cover (see Service cover on page 83)

b. Optical drive (see Optical drive on page 84)

¢. Hard drive (see Hard drive on page 87)

d. WWAN module (see WWAN module on page 92)

e. WIAN module (see WLAN module on page 94)

f. Fan (see Fan on page 100)

g. Keyboard (see Keyboard on page 101)

=2 NOTE: When replacing the base enclosure, be sure to remove the following components from
the defective base enclosure and install them on the replacement base enclosure:

®  Speaker assembly (see Speaker assembly on page 111)

e RJ11 jack assembly (see RJ-11 jack cable on page 112)

Remove the base enclosure:
1. Close the computer.
2. Turn the computer upside down, with the front toward you.

3. Remove the three rubber screw covers (1), (2), and (3). Note that the rubber screw covers are
three different sizes and shapes. The rubber screw covers are included in the Rubber Kits, spare
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part numbers 641192-001 (for use only on HP EliteBook 8570p Notebook PC computer models)
and 646608-001 (for use only on HP ProBook 6570b Notebook PC computer models).

4. Remove the six Torx PM2.5x6.0 screws (4) that secure the base enclosure to the computer.

5. Remove the following seven Phillips PM2.0x3.6 screws that secure the base enclosure to
the computer:

(1) Three screws in the optical drive bay
(2) Two screws in the battery bay

(3) Two screws in the hard drive bay
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6. Position the computer with the battery bay toward you.

7. Remove the four Torx TM2.5x6.0 screws from the rear panel of the computer.

8. Release the wireless antenna cables from the routing channel (1) built into the base enclosure.

9. Disconnect the speaker cable from the system board (2).

10. Press the tab in the battery bay (1) to disengage the base enclosure from the computer.
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11. Remove the base enclosure from the computer (2).

Reverse this procedure to install the base enclosure.
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Speaker assembly

Description Spare part number

Speaker assembly (includes cable) 641186001

Before removing the speaker assembly, follow these steps:

1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

Disconnect all external devices from the computer.

Remove the battery (see Battery on page 81), and then remove the following components:

b.

o

-
h

g.
h

Service cover (see Service cover on page 83)

Optical drive (see Optical drive on page 84)

Hard drive (see Hard drive on page 87)

WWAN module (see WWAN module on page 92)

WLAN module (see WLAN module on page 94)

Fan (see Fan on page 100)

Keyboard (see Keyboard on page 101)

Base enclosure (see Base enclosure on page 107)

Remove the speaker assembly:

1.
2.

Turn the base enclosure right-side up.

Position the base enclosure with the front toward you.

Remove the two Phillips PM2.0x3.0 screws (1) that secure the speaker assembly to
the base enclosure.
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4. Remove the speaker assembly (2) from the base enclosure.

Reverse this procedure to install the speaker assembly.

RJ-11 jack cable

@NOTE: The RJ-11 jack cable is included in the Cable Kits, spare part numbers 686308-001 (for use
only on HP EliteBook 8570p Notebook PC computer models) and 686307-001 (for use only on HP
ProBook 6570b Notebook PC computer models).

Before removing the RJ-11 jack cable, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 81), and then remove the following components:

a. Service cover (see Service cover on page 83)

b. Optical drive (see Optical drive on page 84)

¢. Hard drive (see Hard drive on page 87)

d. WWAN module (see WWAN module on page 92)

e. WILAN module (see WLAN module on page 94)

f. Fan (see Fan on page 100)
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g. Keyboard (see Keyboard on page 101)

h. Base enclosure (see Base enclosure on page 107)

Remove the RJ-11 jack cable:
1. Turn the base enclosure right-side up.
Position the base enclosure with the front toward you.

Release the RJ-11 jack from the clip (1) built into the base enclosure.

L

Release the RJ-11 jack cable from the clips (2) and routing channel built into the base enclosure.

5. Remove the RJ-11 jack cable.

Reverse this procedure to install the RJ-11 jack cable.
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Function board
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Description Spare part number

Function board 686313-001

Before removing the function board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 81), and then remove the following components:

b.

h.

Service cover (see Service cover on page 83)

Optical drive (see Optical drive on page 84)

Hard drive (see Hard drive on page 87)

WWAN module (see WWAN module on page 92)

WLAN module (see WLAN module on page 94)

Fan (see Fan on page 100)

Keyboard (see Keyboard on page 101)

Base enclosure (see Base enclosure on page 107)

Remove the function board:

1. Release the wireless antenna cables (1) from the clip (2) built into the function board.

2. Remove the three Phillips PM2.5x5.0 screws (3) that secure the function board to the computer.
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3. Remove the function board (4).

Reverse this procedure to install the function board.
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Power connector cable

@NOTE: The power connector cable is included in the Cable Kits, spare part numbers 686308-001
(for use only on HP EliteBook 8570p Notebook PC computer models) and 686307-001 (for use only
on HP ProBook 6570b Notebook PC computer models).

Before removing the power connector cable, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 81), and then remove the following components:

a. Service cover (see Service cover on page 83)

b. Optical drive (see Optical drive on page 84)

¢. Hard drive (see Hard drive on page 87)

d. WWAN module (see WWAN module on page 92)

e.  WILAN module (see WLAN module on page 94)

f.  Fan (see Fan on page 100)

Keyboard (see Keyboard on page 101)

h. Base enclosure (see Base enclosure on page 107)

Remove the power connector cable:
1. Turn the computer right-side up, with the front toward you.

2. Open the computer.
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3. Disconnect the power connector cable from the system board.

4. Close the computer.
5. Turn the computer upside down, with the front toward you.

6. Release the power connector cable (1) from the opening, clips (2), and routing channel built into
the top cover.
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7. Remove the power connector (3) from the clip built into the top cover.

Reverse this procedure to install the power connector cable.
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USB board

Description Spare part number

USB board 686314-001

Before removing the USB board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 81), and then remove the following components:

a. Service cover (see Service cover on page 83)

b. Optical drive (see Optical drive on page 84)

¢. Hard drive (see Hard drive on page 87)

d. WWAN module (see WWAN module on page 92)

WLAN module (see WLAN module on page 94)

o

-
h

Fan (see Fan on page 100)

g. Keyboard (see Keyboard on page 101)
h.

Base enclosure (see Base enclosure on page 107)

Remove the USB board:
1. Release the clip (1) built into the top cover that secures the left side of the USB board.

2. Lift the left side of the USB board (2) to disconnect the board from the system board.
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3. Remove the USB board (3).

Reverse this procedure to install the USB board.
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System board

E’%NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

For use only on HP EliteBook 8570p Notebook PC computer models equipped with the QM77 686970-601
chipset, a graphics subsystem with discrete memory, and the Windows 8 Professional operating
system in all countries and regions except the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with the QM77 686970-501
chipset, a graphics subsystem with discrete memory, and the Windows 8 Standard operating
system in all countries and regions except the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with the QM77 686970001
chipset, a graphics subsystem with discrete memory, and the Windows 7 operating system in all
countries and regions except the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with the QM77 690021-601
chipset, a graphics subsystem with discrete memory, and the Windows 8 Professional operating
system only in the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with the QM77 690021-501
chipset, a graphics subsystem with discrete memory, and the Windows 8 Standard operating
system only in the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with the QM77 690021-001
chipset, a graphics subsystem with discrete memory, and the Windows 7 operating system only in
the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with the QM77 686971-601
chipset, a graphics subsystem with UMA memory, and the Windows 8 Professional operating
system in all countries and regions except the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with the QM77 686971-501
chipset, a graphics subsystem with UMA memory, and the Windows 8 Standard operating system
in all countries and regions except the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with the QM77 686971-001
chipset, a graphics subsystem with UMA memory, and the Windows 7 operating system in all
countries and regions except the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with the QM77 690022-601
chipset, a graphics subsystem with UMA memory, and the Windows 8 Professional operating
system only in the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with the QM77 690022-501
chipset, a graphics subsystem with UMA memory, and the Windows 8 Standard operating system
only in the People's Republic of China and the Ukraine

For use only on HP EliteBook 8570p Notebook PC computer models equipped with the QM77 690022001
chipset, a graphics subsystem with UMA memory, and the Windows 7 operating system only in
the People's Republic of China and the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 686976-601
chipset, a graphics subsystem with discrete memory, WWAN capability, and the Windows 8

Professional operating system in all countries and regions except the People's Republic of China

and the Ukraine
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Description Spare part number

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 686976501
chipset, a graphics subsystem with discrete memory, WWAN capability, and the Windows 8

Standard operating system in all countries and regions except the People's Republic of China and

the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 686976-001
chipset, a graphics subsystem with discrete memory, WWAN capability, and the Windows 7

operating system in all countries and regions except the People's Republic of China and

the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 690027-601
chipset, a graphics subsystem with discrete memory, WWAN capability, and the Windows 8
Professional operating system only in the People's Republic of China and the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 690027-501
chipset, a graphics subsystem with discrete memory, WWAN capability, and the Windows 8
Standard operating system only in the People's Republic of China and the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 690027-001
chipset, a graphics subsystem with discrete memory, WWAN capability, and the Windows 7
operating system only in the People's Republic of China and the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 686974-601
chipset, a graphics subsystem with UMA memory, WWAN capability, and the Windows 8

Professional operating system in all countries and regions except the People's Republic of China

and the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 686974-501
chipset, a graphics subsystem with UMA memory, WWAN capability, and the Windows 8

Standard operating system in all countries and regions except the People's Republic of China and

the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 686974-001
chipset, a graphics subsystem with UMA memory, WWAN capability, and the Windows 7

operating system in all countries and regions except the People's Republic of China and

the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 690025-601
chipset, a graphics subsystem with UMA memory, WWAN capability, and the Windows 8
Professional operating system only in the People's Republic of China and the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 690025-501
chipset, a graphics subsystem with UMA memory, WWAN capability, and the Windows 8
Standard operating system only in the People's Republic of China and the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 690025-001
chipset, a graphics subsystem with UMA memory, WWAN capability, and the Windows 7
operating system only in the People's Republic of China and the Ukraine

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 703887-601
chipset, a graphics subsystem with UMA memory, and the Windows 8 Professional operating

system in all countries and regions except the People's Republic of China and the Ukraine

(includes replacement thermal material)

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77 703887-501
chipset, a graphics subsystem with UMA memory, and the Windows 8 Standard operating system

in all countries and regions except the People's Republic of China and the Ukraine (includes

replacement thermal material)
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Description

Spare part number

For use only on HP ProBook 6570b Notebook PC computer models equipped with the QM77
chipset, a graphics subsystem with UMA memory, and the Windows 7 operating system in all
countries and regions except the People's Republic of China and the Ukraine (includes
replacement thermal material)

703887-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with discrete memory, WWAN capability, and the Windows 8

Professional operating system in all countries and regions except the People's Republic of China

and the Ukraine

686975-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with discrete memory, WWAN capability, and the Windows 8

Standard operating system in all countries and regions except the People's Republic of China and

the Ukraine

686975-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with discrete memory, WWAN capability, and the Windows 7
operating system in all countries and regions except the People's Republic of China and

the Ukraine

686975-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with discrete memory, WWAN capability, and the Windows 8
Professional operating system only in the People's Republic of China and the Ukraine

690026-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with discrete memory, WWAN capability, and the Windows 8
Standard operating system only in the People's Republic of China and the Ukraine

690026-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with discrete memory, WWAN capability, and the Windows 7
operating system only in the People's Republic of China and the Ukraine

690026-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with UMA memory, WWAN capability, and the Windows 8

Professional operating system in all countries and regions except the People's Republic of China

and the Ukraine

686973-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with UMA memory, WWAN capability, and the Windows 8

Standard operating system in all countries and regions except the People's Republic of China and

the Ukraine

686973-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with UMA memory, WWAN capability, and the Windows 7
operating system in all countries and regions except the People's Republic of China and

the Ukraine

686973-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with UMA memory, WWAN capability, and the Windows 8
Professional operating system only in the People's Republic of China and the Ukraine

690024-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with UMA memory, WWAN capability, and the Windows 8
Standard operating system only in the People's Republic of China and the Ukraine

690024-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with UMA memory, WWAN capability, and the Windows 7
operating system only in the People's Republic of China and the Ukraine

690024-001
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Description

Spare part number

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with UMA memory, and the Windows 8 Professional operating
system in all countries and regions except the People's Republic of China and the Ukraine

686972-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with UMA memory, and the Windows 8 Standard operating system
in all countries and regions except the People's Republic of China and the Ukraine

686972-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with UMA memory, and the Windows 7 operating system in all
countries and regions except the People's Republic of China and the Ukraine

686972-001

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with UMA memory, and the Windows 8 Professional operating
system only in the People's Republic of China and the Ukraine

690023-601

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with UMA memory, and the Windows 8 Standard operating system
only in the People's Republic of China and the Ukraine

690023-501

For use only on HP ProBook 6570b Notebook PC computer models equipped with the HM76
chipset, a graphics subsystem with UMA memory, and the Windows 7 operating system only in
the People's Republic of China and the Ukraine

690023-001

Before removing the system board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn

the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 81), and then remove the following components:

a. Service cover (see Service cover on page 83)

b. Optical drive (see Optical drive on page 84)

c. Hard drive (see Hard drive on page 87)

d. WWAN module (see WWAN module on page 92)

e. WILAN module (see WLAN module on page 94)

f. Fan (see Fan on page 100)

g. Keyboard (see Keyboard on page 101)

h. Base enclosure (see Base enclosure on page 107)
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[Bf NOTE:  When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

Memory module (see Memory module on page 90)

Heat sink (see Heat sink on page 127)

Processor (see Processor on page 130)

Remove the system board:

1.
2.
3.

0 ® N o

Turn the computer rightside up, with the front toward you.
Open the computer.

Release the ZIF connector (1) to which the Touchpad cable is connected, and then disconnect
the Touchpad cable (2) from the system board.

Release the ZIF connector (3) to which the fingerprint reader board cable is connected, and then
disconnect the fingerprint reader board cable (4) from the system board.

Disconnect the power connector cable (5) from the system board.

Close the computer.
Turn the computer upside down, with the battery bay toward you.
Remove the Torx TM2.5x4.8 screw (1) that secures the ground loop (2) to the left display hinge.

Release the display panel cable (3) from the routing channel (4) attached to the system board.
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10. Disconnect the display panel cable (5) from the system board.

11. Remove the four Phillips PM2.5x5.0 screws (1) that secure the system board to the top cover.

12. Lift the right side of the system board (2) until it rests at an angle.
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13. Remove the system board (3) by sliding it up and to the right at an angle.

Reverse this procedure fo install the system board.

Heat sink

E’%NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number
For use only on computer models equipped with a graphics subsystem with discrete memory 686310001
For use only on computer models equipped with a graphics subsystem with UMA memory 686309001

Before removing the heat sink, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 81), and then remove the following components:

a. Service cover (see Service cover on page 83)

b. Optical drive (see Optical drive on page 84)

c. Hard drive (see Hard drive on page 87)
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d. WWAN module (see WWAN module on page 92)

e. WILAN module (see WLAN module on page 94)

f. Fan (see Fan on page 100)

Keyboard (see Keyboard on page 101)

= @

Base enclosure (see Base enclosure on page 107)

System board (see System board on page 121)

Remove the heat sink:

1. Turn the system board upside down, with the front toward you.

E‘/f'NOTE: Step 2 applies to computer models equipped with a graphics subsystem with discrete
memory. See step 3 for heat sink removal information for computer models equipped with a
graphics subsystem with UMA memory.

2. Following the 1, 2, 3, 4, 5, 6, 7 sequence stamped into the heat sink, loosen the seven captive
Philllips screws (1) and (2) that secure the heat sink to the system board, and then remove

the heat sink (3).

E’%NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
the system board components, it may be necessary to move the heat sink from side to side to
detach it.

3. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four captive Philllips
screws (1) that secure the heat sink to the system board, and then remove the heat sink (2).

E‘/fNOTE: Due to the adhesive quality of the thermal material located between the heat sink and
the system board components, it may be necessary to move the heat sink from side to side to
detach it.
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B NOTE:  The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
the system board components each time the heat sink is removed. Replacement thermal material is
included with the heat sink, processor, and system board spare part kits.

The following illustration shows the replacement thermal material locations on a computer model
equipped with a graphics subsystem with discrete memory.

e  Thermal paste is used on the processor (1) and the heat sink section (2) that services it

e  Athermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that
services it

e  Thermal paste is used on the PCH chip (5) and the heat sink section (6) that services it
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The following illustration shows the replacement thermal material locations on a computer model
equipped with a graphics subsystem with UMA memory.

e Thermal paste is used on the processor (1) and the heat sink section (2) that services it

e  Thermal paste is used on the PCH chip (3) and the heat sink section (4) that services it

Reverse this procedure to install the heat sink.

Processor

%NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

Intel Quad Core i7-3740QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 702840-001
6.0-MB L3 cache, 45 W) for use only on HP EliteBook 8570p Notebook PC computer models

Intel Quad Core i7-3720QM 2.60-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 681283-001
6.0-MB L3 cache, 45 W) for use only on HP EliteBook 8570p Notebook PC computer models

Intel Quad Core i7-3630QM 2.40-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz FSB, 702081-001
6.0-MB L3 cache, 45 W) for use only on HP EliteBook 8570p Notebook PC computer models

Intel Quad Core i7-3610QM 2.30-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB, 680646-001
6.0-MB L3 cache, 45 W) for use only on HP EliteBook 8570p Notebook PC computer models

Intel Dual Core i7-3540M 3.00-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 4.0- 710787-001
MB L3 cache, 45 W) for use on all computer models

Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 4.0- 681954-001
MB L3 cache, 35 W) for use on all computer models

Intel Dual Core i5-3380M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 3.0-  708762-001
MB L3 cache, 35 W) for use on all computer models
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Description

Spare part number

Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz FSB, 3.0-  681953-001
MB L3 cache, 35 W) for use on all computer models

Intel Dual Core i5-3340M 2.70-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz FSB, 3.0-  708761-001
MB L3 cache, 35 W) for use on all computer models

Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB, 3.0-  681952-001
MB L3 cache, 35 W) for use on all computer models

Intel Dual Core i5-3230M 2.60-GHz processor (SC turbo up to 3.20-GHz; 1600-MHz FSB, 3.0- 711903-001
MB L3 cache, 35 W) for use on all computer models

Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0- 680645-001
MB L3 cache, 35 W) for use on all computer models

Intel Dual Core i3-3130M 2.60-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) foruse  713163-001
only on HP ProBook 6570b Notebook PC computer models

Intel Dual Core i3-3120M 2.50-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) for use  700627-001
only on HP ProBook 6570b Notebook PC computer models

Intel Dual Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) for use  682417-001
only on HP ProBook 6570b Notebook PC computer models

Intel Dual Core i3-2370M 2.40-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) foruse  677152-001

only on HP ProBook 6570b Notebook PC computer models

Before removing the processor, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn

the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 81), and then remove the following components:

a. Service cover (see Service cover on page 83)

b. Optical drive (see Optical drive on page 84)

¢. Hard drive (see Hard drive on page 87)

d. WWAN module (see WWAN module on page 92)

e. WILAN module (see WLAN module on page 94)

f. Fan (see Fan on page 100)

g. Keyboard (see Keyboard on page 101)

h. Base enclosure (see Base enclosure on page 107)

i.  System board (see System board on page 121)

j-  Heat sink (see Heat sink on page 127)
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Remove the processor:

1. Use a flat-bladed screw driver (1) to turn the processor locking screw one-half turn
counterclockwise, until you hear a click.

2. Llift the processor (2) straight up, and remove it.

E’%NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon (4)
embossed on the processor socket when you install the processor.

Reverse this procedure to install the processor.
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Display assembly

E’%NOTE: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.

Before removing the display assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 81), and then remove the following components:

a. Service cover (see Service cover on page 83)

b. Optical drive (see Optical drive on page 84)

¢. Hard drive (see Hard drive on page 87)

d. WWAN module (see WWAN module on page 92)

e. WILAN module (see WLAN module on page 94)

="
.

Fan (see Fan on page 100)

g. Keyboard (see Keyboard on page 101)
h.

Base enclosure (see Base enclosure on page 107)

Remove the display assembly:
1. Remove the Torx TM2.5x4.8 screw (1) that secures the ground loop (2) to the left display hinge.

2. Disconnect the display panel cable (3) from the system board, and then release the display panel
cable from the routing channel (4) attached to the system board.

3. Release the wireless antenna cables (5) from the routing channel attached to the system board.

4. Remove the four Phillips PM2.5x4.0 screws (6) that secure the display assembly to the top cover.
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5. Swing the display hinges (7) up and back until the top cover is free for removal.

6. Position the computer with the front toward you.
7. Press the display release latch (1) to release the display assembly from the top cover.

8. Remove the computer (2) from the display assembly.
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9. Ifitis necessary to replace the display bezel or any of the display assembly subcomponents:

a. Remove the rubber screw covers (1). The rubber screw covers are available in the Rubber
Kits, spare part numbers 641192-001 (for use only on HP EliteBook 8570p Notebook PC
computer models) and 686303-001 (for use only on HP ProBook 6570b Notebook PC

computer models).

b. Remove the two Phillips PM2.5x5.0 screws (2) that secure the display bezel to
the display assembly.

c. Flex the inside edges of the bottom edge (1), the left and right sides (2), and
the top edge (3) of the display bezel until the bezel disengages from the display enclosure.
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d. Remove the display bezel (4). The display bezel is available using spare part numbers
686304-001 (for use only on HP EliteBook 8570p Notebook PC computer models) and
686303-001 (for use only on HP ProBook 6570b Notebook PC computer models).

10. If it is necessary to replace the webcam/microphone module:

a. Release the shielding tabs that secure the webcam/microphone module (1) to
the display enclosure.

b. Detach the webcam/microphone module (2) from the display enclosure. (The webcam/
microphone module is attached to the display enclosure with double-sided tape.)

c. Disconnect the webcam/microphone module cable (3) from the webcam/
microphone module.

CAUTION: Handle the webcam/microphone module with caution. The module has a thin
p
profile and is susceptible to damage when not handled carefully.
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d. Remove the webcam/microphone module (4). The webcam/microphone module is available
using spare part numbers 699688-001 (with keyboard light for use only on HP EliteBook
8570p Notebook PC computer models) and 699687-001 (without keyboard light for use
only on HP ProBook 6570b Notebook PC computer models).

11. If it is necessary to replace the display panel:

B NOTE:  Substeps a through c apply to an HP EliteBook 8570p Notebook PC computer model.
See substeps d through f for display panel release procedures for an HP EliteBook 6570b
Notebook PC computer models.

a. Remove the two Phillips PM2.5x4.6 screws (1) that secure the top edge of the display panel
to the display enclosure.

b. Remove the four Phillips PM2.5%5.6 screws (2) that secure the display hinges and the bottom
edge of the display panel to the display enclosure.
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c. lift the top edge of the display panel (1), and then swing it up and forward until it rests at an
upright position.

E%NOTE: Substeps d through f apply to an HP EliteBook 6570b Notebook PC
computer model. See substeps a through c for display panel release procedures for an HP
EliteBook 8570p Notebook PC computer model.

d. Remove the eight Phillips PM2.5x4.0 screws (1) that secure the display panel to
the display enclosure.

e. lift the top edge of the display panel (2), and then swing it up and forward until it (3) rests
at an upright position.

f.  Position the display enclosure and display panel with the display panel cable connector
toward you.

g. Release the adhesive support strip (1) that secures the display panel cable to
the display panel.
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h. Disconnect the display panel cable (2) from the display panel.

i.  Remove the display panel. The display panel is available using the following spare
part numbers:

e 690405-001—15.6-in, LED, AntiGlare, WVA, FHD, display panel
®  690404-001—15.6-in, LED, AntiGlare, WVA, HD+, display panel
e  690403-001—15.6-in, LED, AntiGlare, SVA, HD, display panel
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12. If it is necessary to replace the display hinges:

r__f"%NOTE: Substeps a through e apply to an HP EliteBook 8570p Notebook PC computer model.
See substeps f through i for display hinge removal procedures for an HP EliteBook 6570b
Notebook PC computer model.

a. Remove the display hinges from the display enclosure.

b. Remove the two Phillips PM2.0x3.0 screws that hold the display hinge assembly together.
c. Remove the display hinge inner cover (2).

d. Remove the display hinge end cap (3).
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Remove the display hinge outer cover (4). The display hinges, inner and outer covers, and
end caps are included in the Display Hinge Kit, spare part number 641193-001.

E/;’NOTE: Substeps a through e apply to an HP EliteBook 8570p Notebook PC
computer model. See substeps f through i for display hinge removal procedures for an HP
EliteBook 6570b Notebook PC computer model.

f.  Remove the two Phillips PM2.0x3.0 screws (1) that secure the display hinge covers to
the display assemblies.

g. Slide the display hinges toward the inside of the display enclosure (2) to remove them. The
display hinge covers are included in the Display Hinge Kit, spare part number 647677-001.

h. Remove the eight Phillips PM2.5x3.0 screws (1) that secure display hinge assemblies to
the display panel.
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i.  Remove the display hinge assemblies (2). The display hinge assemblies are included in
the Display Hinge Kit, spare part number 647677-001.

13. If it is necessary to replace the display panel cable:

a. Remove the five Phillips PM2.0x3.0 screws that secure the display hinge tube to
the display enclosure.

@NOTE: Substeps a through d apply only to an HP EliteBook 6570b Notebook PC
computer model.

b. Release the display hinge tube (1) from the display enclosure.
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c. Release the display panel cable (2) and the wireless antenna cables (3) from the display
hinge tube.

E%NOTE: When releasing the display panel cable and wireless antenna cables, make note of
the location of the display assembly cable guides (4) inside the display hinge tube.

d. Remove the display hinge tube. The display hinge tube and the display cable guides are
included in the Display Hinge Kit, spare part numbers 641193-001 (for use only on HP
EliteBook 8570p Notebook PC computer models) and 647677-001 (for use only on HP
EliteBook 6570b Notebook PC computer models).

e. Disconnect the webcam/microphone module cable (1) from the webcam/
microphone module.

f. Release the display panel cable (2) from the clips and routing channel built into
display enclosure.
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g. Detach the display panel cable (3) from the display enclosure. (The display panel cable is
attached to the display enclosure with double-sided tape.)

h. Remove the display panel cable. The display panel cable is available using the following
spare part numbers:

e 686306-001—For use only on HP EliteBook 8570p Notebook PC computer models
equipped with an FHD or HD+ display assembly

e 686305-001—For use only on HP EliteBook 8570p Notebook PC computer models
equipped with an HD display assembly

e 646970-001—For use only on HP ProBook 6570b Notebook PC computer models
equipped with an FHD or HD+ display assembly

e 646969-001—For use only on HP ProBook 6570b Notebook PC computer models
equipped with an HD display assembly

14. If it is necessary to replace the WLAN antenna cables and transceivers:

a. Release the WLAN antenna cables from the clips (1) and routing channel built into
the display enclosure.

b. Detach the WLAN antenna transceivers (2) from the display enclosure. (The WLAN antenna
transceivers are attached to the display enclosure with double-sided tape.)
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c. Remove the WLAN antenna cables and transceivers (3). The WLAN antenna cables and
transceivers are included in the Cable Kits, spare part numbers 686308-001 (for use only on
HP EliteBook 8570p Notebook PC computer models) and 686307-001 (for use only on HP
ProBook 6570b Notebook PC computer models).

15. If it is necessary to replace the WWAN antenna cables and transceivers:

a. Release the WWAN antenna cables from the clips (1) and routing channel built into
the display enclosure.

b. Detach the WWAN antenna transceivers (2) from the display enclosure. (The WWAN
antenna transceivers are attached to the display enclosure with double-sided tape.)
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c. Remove the WWAN antenna cables and transceivers (3). The WWAN antenna cables and
transceivers are included in the Cable Kits, spare part numbers 686308-001 (for use only on
HP EliteBook 8570p Notebook PC computer models) and 686307-001 (for use only on HP
ProBook 6570b Notebook PC computer models).

Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup (BIOS) and
Advanced System Diagnostics

Windows 8

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

E’%NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

r__f'%NOTE: An external keyboard or mouse connected to a USB port can be used with Computer
Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

4

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu
message is displayed at the bottom of the screen.

2. Press {10 to enter Computer Setup.
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Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e  To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press entfer, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e  To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

@NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

e  To exit Computer Setup menus without saving your changes:
Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.
—or—

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

e To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

—or —

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup

[ NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

o S

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E‘jNOTE: Your password settings and security settings are not changed when you restore the
factory seftings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.
2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

Windows 8 149



Downloading a BIOS update

/\ CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type h, and then select Help and Support.

2. Inthe Help and Support search box, type maintain, and then follow the on-screen
instructions to identify your computer and access the BIOS update you want to download.

3. At the download areq, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

@NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type e, and then click File Explorer.
2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Doubleclick the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

@NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

e  System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

e  Startup test—This test analyzes the main computer components that are required to start
the computer.

®  Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

®  Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

®  Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

e  Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact HP support to report the issue and purchase a
replacement battery.

e  BIOS Management—You can update or rollback the version of the BIOS on the system. Do not
shut down or remove external power during the process. You will be given a confirmation screen
before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to
main menu.

You can view system information and error logs or select languages in the Advanced System
Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press 2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

E’jNOTE: NOTE: you need to stop a diagnostics test while it is running, press esc.
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Windows 7

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

@NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

@NOTE: An external keyboard or mouse connected to a USB port can be used with Computer
Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press {10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press entfer, or use a pointing device to click the item.

e  To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e  To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

E%NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:

® To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

—or —

e To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

—Oor —

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

E’%NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

L S

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E’/f’NOTE: Your password settings and security settings are not changed when you restore the
factory seftings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:
1. Start Computer Setup.
2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enfer.

@NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the 1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

/\ CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your Web browser. For U.S. support, go to hitp://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.
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3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.

Click your specific product from the models listed.

Click the appropriate operating system.

o o &

Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

E’%NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

e  Start-up test—This test analyzes the main computer components that are required to start
the computer.

®  Run-in test—This fest repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

e  Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

®  Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

®  Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

e  System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.
To start Advanced System Diagnostics:

1. 1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press {2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

E’/fNOTE: If you need to stop a diagnostics test while it is running, press esc.
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SuUSE Linux (SLED)

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

@NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

@NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press {10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press entfer, or use a pointing device to click the item.

e  To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e  To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

E‘jNOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
To exit Computer Setup menus, choose one of the following methods:

e  To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

—or —
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Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

—Oor —

® To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

[Bf NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press 10 to enter Computer Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

o S A

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E’%’NOTE: Your password settings and security settings are not changed when you restore the factory
seftings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:
1. Start Computer Setup.
2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

B NOTE:  You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the 1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

/\ CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For
worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.

Click your specific product from the models listed.
Click the appropriate operating system.

Go to the BIOS section and download the BIOS software package.

N s » s

Follow the installation instructions as provided with the downloaded BIOS software package.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

e  Start-up test—This test analyzes the main computer components that are required to start the
computer.

®  Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

®  Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

®  Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

e  Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

e  System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.
To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press 2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

@NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

Metric u.s.
Dimensions
Width 37.40 cm 14.72 in
Depth 25.05 cm 9.86in
Height (front to back) 3.41 to 3.61 cm 1.3410 1.42in
Weight
Equipped with 3-cell battery, graphics subsystem with 2.61 kg 5.75 lbs
UMA memory, one memory module, WLAN module, and
solid-state drive
Equipped with 3-cell battery, optical drive, graphics 2.71 kg 5.97 lbs
subsystem with UMA memory, one memory module, and
WLAN module
Equipped with é-cell battery, graphics subsystem with 2.74 kg 6.04 Ibs
UMA memory, one memory module, WLAN module, and
solid-state drive
Equipped with é-cell battery, optical drive, graphics 2.84 kg 6.26 LBS
subsystem with UMA memory, one memory module,
WILAN module, and solid-state drive
Equipped with 9-cell battery, graphics subsystem with 2.91 kg 6.41 lbs
UMA memory, one memory module, WLAN module, and
solid-state drive
Equipped with 9-cell battery, optical drive, graphics 3.00 kg 6.63 lbs
subsystem with UMA memory, one memory module,
WILAN module, and solid-state drive
Input power
Operating voltage and current 185Vdc@3.5A-65W

—or—

19.0Vdc@4.74 A-90 W

Temperature
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Metric U.S.

Operating 5°Cto 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 mto 3,048 m -50 ft to 10,000 ft

Nonoperating -15mto 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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15.6-inch WGA display specifications
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Metric u.s.
Dimensions
Height 19.6 cm 7.72in
Width 34.7 cm 13.66 in
Diagonal 39.8 cm 15.67 in

Number of colors

up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

250 nits (typical)

Pixel resolution

Pitch

0.197 X 0.197 mm

Format

FHD, WVA (1920 x 1080)
HD+, WVA (1600 x 1900)

HD, SVA (1366 x 768)

Configuration

RGB vertical stripe

Backlight LED
Character display 80 x 25
Total power consumption 3.46 W

Viewing angle

+65° horizontal, +50° vertical (typical)
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Hard drive specifications

750-GB* 500-GB* 320-GB*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm
Length 100.2 mm 100.4 mm 100.4 mm
Width 69.9 mm 69.9 mm 69.9 mm
Weight 110g 110 g 110g
Interface type SATA SATA SATA
Transfer rate
Synchronous (maximum) 1.1 GB/sec 1.1 GB/sec 1.1 GB/sec
Security ATA security ATA security ATA security
Seek times (typical read, including setting)
Single track 2.0 ms 1.5 ms 1.5 ms
Average (read/write) 12/16 ms 11/13 ms 11/13 ms
Maximum 22 ms 22 ms 22 ms
Logical blocks 1,465,149,168 976,773,168 628,142,448
Disk rotational speed 7200 rpm 7200 rpm 7200 rpm
Operating temperature 0°Cto 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.

Hard drive specifications
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7 Backup and recovery

Windows 8

To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system restore
points. In case of system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

@NOTE: For detailed instructions on various backup and restore options, perform a search for these

topics in Help and Support. From the Start screen, type h, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

@NOTE: Windows includes the User Account Control feature to improve the security of your computer.

You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information. From the Start
screen, type h, and then select Help and Support.

Backing up your information
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Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. As you add new software and data files, you should continue to back up your system
on a regular basis o maintain a reasonably current backup. The system repair media (select models
only) are used to start up (boot) the computer and repair the operating system in case of system
instability or failure. Your initial and subsequent backups allow you to restore your data and settings if
a failure occurs.

From the Start screen, type backup, click Settings, and then select Save backup copies of your
files with File History.

You can back up your information to an optional external hard drive or a network drive.
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Note the following when backing up:
e  Store personal files in the Documents library, and back it up regularly.
®  Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:

E’/fNOTE: Be sure that the computer is connected to AC power before you start the backup process.

E’/{NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. From the Start screen, type backup, click Settings, and then select from the list of
displayed options.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create system repair media (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

®  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e {11 recovery tools: You can use the {11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

E’/f’NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system. For additional information, see the
“Using Windows 8 operating system media (purchased separately)” section.

Using the Windows recovery tools

To recover information you previously backed up:
A From the Start screen, type h, and then select Help and Support.

To recover your information using Startup Repair, follow these steps:

Windows 8
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/\ CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. Al files
you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. |If possible, back up all personal files.

2. |If possible, check for the presence of the HP Recovery partition and the Windows partition.
From the Start screen, type e, and then click File Explorer.
—or—

From the Start screen, type c, and then select Computer.

E’%NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system DVD and the Driver
Recovery media (both purchased separately). For additional information, see the “Using Windows
8 operating system media (purchased separately)” section.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart.

4. Select Startup Repair.

5. Follow the on-screen instructions.

@NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type h, and then select
Help and Support.

Using f11 recovery tools
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/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:
1. |If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type ¢, and
then select Computer.

E’/fNOTE: It the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see the “Using Windows 8 operating system
media (purchased separately)” section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.
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4. Press {11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)

To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.

/\ CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 8 operating system DVD:

E’/f'NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 8 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh for quick and easy recovery

When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.

E’%IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.

E’/fNOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See Help and Support for instructions on reinstalling
traditional applications. From the Start screen, type h, and then select Help and Support.

E’/fNOTE: You may be prompted for your permission or password when using Refresh. See Windows
Help and Support for more information. From the Start screen, type h, and then select
Help and Support.
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To start Refresh:

1.

On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

Click Settings.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

Under Refresh your PC without affecting your files, select Get started, and follow the
on-screen instructions.

Remove everything and reinstall Windows

168

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer fo its original state. This option removes
all personal data, apps, and settings from your computer, and reinstalls Windows.

@IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the {11 key or from the Start screen.

To use the {11 key:

1.

2.
3.

Press f11 while the computer boots.

—or-

Press and hold f11 as you press the power button.
Select Troubleshoot from the boot options menu.

Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:

1.

On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

Click Settings.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

Under Remove everything and reinstall Windows, sclect Get started, and follow the
on-screen instructions.
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Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted
from the system.

1. From the Start screen, type HP Software Setup, and select Apps.
2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.

Windows 7

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only) with
the installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of

your computer.

Windows Backup and Restore provides the following options:

e  Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

®  Backing up your information

®  Creating a system image (select models only)

e  Scheduling automatic backups (select models only)
e  Creating system restore points

®  Recovering individual files

®  Restoring the computer to a previous state

®  Recovering information using recovery tools

E’/{NOTE: For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

E’%NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.
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Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP Recovery
Disc Creator. This recovery media allows you to reinstall your original operating system as well as
select drivers and applications if the hard drive becomes corrupted.

HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:
*  Windows DVD—Installs the operating system without additional drivers or applications.

e Driver DVD—Installs specific drivers and applications only, in the same way that the HP Software
Setup utility installs drivers and applications.

Creating recovery media

E/?’NOTE: The Windows DVD can be created only once. Thereafter, the option to create that media will

not be available.

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.
Select Driver DVD or Windows DVD.

From the drop-down menu, select the drive for burning the recovery media.

Ll S

Click the Burn button to start the burning process.

Backing up your information
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Recovery after a system failure is as good as your most recent backup. Immediately after setting up the
computer, you should create system repair discs (select models only) using the installed optical drive
(select models only) or an optional external optical drive and back up your system. As you add new
software and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. The system repair discs (select models only) are used to start up (boot) the
computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

e  Store personal files in the Documents library, and back it up regularly.

e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

e  When backing up to discs, use any of the following types of discs (purchased separately): CDR,
CD-RW, DVD+R, DVD+R DL, DVDR, DVD-R DL, or DVD+RW. The discs you use will depend on the
type of optical drive you are using.
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@NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

®  When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:

E’/fNOTE: Be sure that the computer is connected to AC power before you start the backup process.

g'/f'NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select
models only), or create a system repair disc (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

®  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e {11 recovery tools: You can use the {11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

E’/f’NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, see the Using a
Windows 7 operating system DVD (purchased separately) section.

Using the Windows recovery tools
To recover information you previously backed up:
1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select
models only), or your files.

To recover your information using Startup Repair, follow these steps:

/\ CAUTION: Some Startup Repair options completely erase hard drive contents and reformat the hard
drive. All files you have created and any software installed on the computer are permanently removed.
When reformatting is complete, the recovery process restores the operating system, as well as the
drivers, software, and utilities from the backup used for recovery.

1. [If possible, back up all personal files.
2. |If possible, check for the presence of the Windows partition.

To check for the Windows partition, select Start > Computer.
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3. If the Windows partition is listed, restart the computer, and then press {8 before the Windows
operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

E/?’NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools
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/\ CAUTION: Using 11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at
the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, rightclick Computer,
click Manage, and then click Disk Management.

E"jNOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see the Using a Windows 7
operating system DVD (purchased separately) section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press {11 while the “Press <F11>" for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to

http:// www.hp.com/go/contactHP. For worldwide support, go to hitp://welcome.hp.com/country
us/en/ wwcontact_us.html. You can also order the DVD by calling support. For contact information,
see the Worldwide Telephone Numbers booklet included with the computer.

/\ CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

E’/fNOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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SuUSE Linux (SLED)

Recovery after a system failure is as good as your most recent backup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if

ever needed.

Creating backups

1. Create restore media immediately after you set up the computer. For more information, see the
“Performing a system recovery” section.

2. Asyou add files, routinely create a backup of your system and personal information.

Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up
your system at the following times:

®  Atregularly scheduled times

e  Before the computer is repaired or restored

e  Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click
Backup my home directory.

2. Click Storage Destination Location, and then select a location to back up your information.

3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled
time.

To immediately back up your information, click the Backup Now check box.

E’jNOTE: Before you back up your information, be sure you have designated a location to save
the backup files.

4. Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.
2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.
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4. To restore all files from the selected location, click Restore all files. To restore select files only,
click Restore selected files, click Select Files and then select the files to be restored.

5. Under Restore Point, click the time and date of the backup.

@}NOTE: If multiple backups have been performed, click Use the latest version to restore the
latest version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery

Recovery allows you to repair or restore the computer to its original factory state. You can create an HP
Factory Image Restore DVD, using an installed or an external DVD+RW optical drive.

/\ CAUTION: CAUTION: Using Recovery completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The recovery tool reinstalls the original operating system and HP programs and drivers that were
installed at the factory. Software, drivers, and updates not installed by HP must be manually reinstalled.
Personal files must be restored from a backup.

To restore the computer using the HP Factory Image Restore DVD, you must first create the recovery
disc. To create the recovery disc:

@NOTE: HP recommends that you create the HP Factory Image Restore DVD in the event of a system
failure.

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image Restore DVD in the
right pane.

3. Follow the on-screen instructions to create an image file to burn a recovery disc.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.

2. Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.

3. As the computer is restarting, press {9 to open the Computer Setup boot option menu.

4. Press the down arrow to select Restore SLED HP-BNB preload image from the Linux boot

menu, and then press enter.

5. Using the arrow keys, select Yes when prompted: Do you want to start the System-
Restore?

6. Follow the on-screen instructions.
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USB Recovery option (select models only)

176

The USB Recovery Disk On Key (flash drive) option allows you to create a backup image of the SLED
operating system installed on select HP Business Notebooks. This Disk On Key may be used to restore
the system to the original factory state when the F11 recovery option is not available. This process
should be done on first obtaining the computer.

/\ CAUTION: The USB recovery option does not preserve data present on the computer’s hard drive or
on the Disk On Key used for the recovery process. Back up any data on the Disk on Key or the
notebook that will be recovered before starting.

@NOTE: HP recommends that you create the USB Recovery Disk in the event of a system failure. The
Disk On Key used for this process should be 4 GB or larger.

Creating a USB Recovery Disk On Key

1.

7.

S o

Connect the USB Disk On Key to a USB port on the computer.

Select Computer > More applications > Tools > Create Recovery USB.
Enter the root password when prompted.

Select USB Disk On Key from the list.

Click OK.

A question dialog will remind you that the data on the USB key will be destroyed. To continue,
click OK. Otherwise, click Cancel and back up the contents of the Disk On Key on another
computer.

The backup process will display a status dialog box while the backup is in progress.

E’/f’NOTE: A file browser window with the Disk On Key Contents displayed will pop up when the

key is mounted. You may close the file browser window if desired. Once the USB Recovery Key
has been created, the status dialog will close. The USB Recovery Key is ready for use.

Recovering from a USB Recovery Disk On Key

/\ CAUTION: Before starting the Recovery process, make sure any data on the system to be recovered
has been backed up. The recovery process destroys all data on the system to be recovered.

1.

2
3
4.
5

Turn off the computer.

Connect the USB Disk On Key to a USB port on the computer.

Turn on the computer while holding down the {9 key.

Once the system has booted, the Boot Options menu should appear.

Using the arrow keys, select USB Disk On Key and press enter.

E’/fNOTE: The description may vary from one USB key to another. Any entry other than Optical

6.

Disk Drive, Notebook Hard Drive or Notebook Ethernet should be the USB Recovery Disk On Key.

Once the USB Recovery Disk On Key has been selected, press enter. The USB Recovery Disk On
Key will boot.
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7. Once the USB Recovery Disk On Key has booted, a dialog box will prompt, “Do you want to start
the System-Restore?” If data on the computer has not been backed up, use the tab key and select
No. The system will reboot. Back up the system data and repeat the previous steps. If no data
should be saved from the computer, use the tab key to select Yes. Press enter to begin the
recovery process.

8. Atfter the files are copied to the system, follow the on-screen instructions.

Remove everything and reinstall SLED

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, applications, and settings from your computer, and reinstalls the Linux operating
system.

E’%IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key.

To use the {11 key:

Press f11 while the computer boots.

—or—

Press and hold {11 as you press the power button.

The following options are available:

e  Cancel/Reboot—Reboots the system. No recovery or restore activity is performed.

®  Recover/Repair System—This option repairs a system that is not working properly and preserves
user data.

®  Restore Factory System—This option restores the system back to the original factory state. User
data is not preserved.

Select an option and follow the on-screen instructions.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries

The following requirements are applicable to all countries and regions:
e  The length of the power cord set must be at least 1.0 m (3.3 ft) and no more than 2.0 m (6.5 ).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e  The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e  The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
ltaly IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China cocC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conducfor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and

rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.

180  Chapter 9 Recycling


http://www.hp.com/recycle

Index

Symbols/Numerics
1394 port 23

A
AC adapter, spare part numbers
51, 66
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